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1. Introduction 

1.1. Overview 
DEX-Pro is a data acquisition utility delivering an automated extraction and control test solution 

with reliable performance for unconnected devices. 

 

Developing a test program in C, C# or LabView is time consuming. However, with DEX-Pro 

easy-to-use graphic user interface and variety of project templates, users can minimize 

development time. 

The software not only extracts machine data, but also helps recognize target machine. Use it as a 

convenient utility to verify devices quickly, or set up an extraction system for production. 

Upon starting the utility, the DEX-Pro interface appears. 

 

Fig.1-1 DEX-Pro interface 

  



2. Getting Started 

2.1. DEX-Pro setting flow 
There are 2 stages for setting DEX-100, edit stage and Runtime stage. 

Edit stage  

During edit stage, user could save the target image for setting script and pages, set up OCR, design 

the OP screen and setup cursor detection, and after finished the all the set-up in the edit stage, you 

can save the related set up and script file for run time stage.  

Runtime stage 

During Runtime stage, there will be 2 modes for you to switch. 

Full Control Mode: 

In the Full Control mode, you can control the machine with the KB and Mouse. However, the script 

will not run under the Full Control Mode. 

Data extraction mode: 

In the Data Extraction Mode, you will run the pre-configured script and start to extract the data.  

 

Fig.2-1 DEX-100 working flow 

2.2. Connections 

2.2.1. Machine’s PC Requirement: 

The main application for DEX-100 is establishing the connection with brown-field PC-based machine 

(Machine without open API and protocols) for valuable data extraction. DEX-100 provided a great 

IOT platform for PC-based machines, through its DEX-Pro, the data from legacy machine could be 



extracted by machine image from display signal. Before the data extraction, the basic requirement 

for the machines are as followed; 

 PC based controllers with VGA or DVI output. 

 PC based controllers with 2 USB port for Keyboard and mouse input or 2 PS/2 port input for 

Keyboard or mouse. 

 Display with VGA or DVI input. 

Note1: There are compatibility issues f when using the KVM with the machine, if you meet the 

problem, please contact your local ADLINK office. 

 

2.2.2. Connect DEX-100 with the machines 

Video interface 

DEX-100 provides 2 kind of the video interface to connect with the machines, one is the VGA 

interface, and the other is the DVI interface. When connecting DEX-100 with the machine, you can 

choose DVI or VGA interface, and only one interface could be supported during the operation. 

Supporting resolution: 

Machine Output Display Resolution Support 

VGA 640 x 480, 60fps  

640 x 480, 75fps  

640 x 480, 85fps 

800 x 600, 60fps  

800 x 600, 75fps  

800 x 600, 85fps  

1024 x 768, 60fps  

1024 x 768, 75fps  

1024 x 768, 85fps 

1152 x 864, 75fps 

1280 x 720, 50 fps 

1280 x 720, 60 fps 

1280 x 768, 60fps 

1280 x 768, 75 fps 

1280 x 768, 85 fps 

1280 x 800, 60 fps 

1280 x 800, 75 fps 

1280 x 800, 85 fps   

1280 x 1024, 60 fps 

1280 x 1024, 75 fps 

1280 x 1024, 85 fps 

1360 x 768, 60 fps 

1366 x 768, 60fps 

1400 x 1050, 60 fps 

1400 x 1050, 75 fps 

1440 x 900, 60 fps 

1600 x 900, 60fps 

1600 x 1200, 60fps 

1680 x 1050, 60 fps 

1920 x 1080, 50 fps 

1920 x 1080, 60 fps 

720 x 400, 60 fps 

720 x 400, 70 fps 

720 x 400, 85 fps 

DVI 640 x 480, 60 fps  1440 x 900, 60 fps 



800 x 600, 60 fps  

1024 x 768, 60 fps  

1024 x 768, 75 fps  

1152 x 864, 75 fps  

1280 x 720, 50 fps  

1280 x 720 , 60 fps  

1280 x 768, 60 fps  

1280 x 800, 60 fps 

1280 x 960, 60 fps 

1280 x1024, 60 fps 

1360 x 768, 60 fps 

1366 x 768, 60 fps 

1440 x 900, 75 fps 

1600 x 1200, 60 fps 

1680 x 1050, 60 fps 

1920 x 1080, 24 fps 

1920 x 1080, 25 fps 

1920 x 1080, 30 fps 

1920 x 1080, 48 fps 

1920 x 1080, 50 fps 

1920 x 1080, 60 fps 

1920 x 1200, 50 fps 

1920 x 1200, 60 fps 

 

For the non-supporting resolution you can find more information in Sec6.7 for configuring the 

unknown resolution. 

NOTE: Due to the video resolution limitation; DEX-Pro will show different resolution as “1368 x 768’ 

when the video source resolution is the 1366 x 768. 

Keyboard/Mouse Interface 

DEX-100 provides 2 kind of the KB/MS interface to connect with the machines, one is the USB 

interface, and the other interface is PS2 interface. When connecting DEX-100 with the machine, you 

can choose USB or PS2 interface, and only one interface could be supported during the operation. 

Supporting OS  

Windows 98 / 2000 / 2003 / XP / Vista / Win 7/, Linux, UNIX, OS2. 

Note: 

When connecting the machine with PS/2 interface, DEX-100 should turn on before the machine. 

Front Panel IO for DEX-Pro application 

DEX-100 reserved certain Video interface IO and Keyboard/Mouse Interface for specific applications. 

In this chapter, the reserved IO will be introduced. 

 



 
Fig.2-2 DEX-100 front panel IO for DEX-PRO application 

 

I/O connectors and controls reserved for DEX-PRO on front panel are as follows 

  VGA Out port 

  DisplayPort 

  PS/2 keyboard port 

  PS/2 mouse port 

  USB2.0 port x2 

  Micro USB type B x2 

  Digital In connectors 

VGA out port 

DEX-PRO SW uses the VGA out port to display the bypass the image from the machine or the OP 

screen setup by the user, and the VGA out port should be always connect with the target machine’s 

monitor when controlling and extracting the data from a machine with VGA monitor. 

DisplayPort 

The Display port shows operating system of DEX-100. 

PS/2 keyboard port 

DEX-PRO SW uses the front panel PS/2 keyboard port to bypass keyboard signal from a PS2 

keyboard to control the machine by the user during the full control mode. This port should connect 

to a PS/2 keyboard. 



PS/2 mouse port 

DEX-PRO SW uses the front panel PS/2 mouse port to bypass mouse signal from a PS2 mouse to 

control the machine by the user during the full control mode. This port should connect to a PS/2 

mouse. 

 

USB2.0 port 

DEX-100 provide 2 USB 2.0 port, and DEX-PRO SW use the front panel USB 2.0 port to bypass mouse 

and keyboard signal from a USB mouse and a USB keyboard to control the machine by the user 

during Full control mode. USB Port 3 is reserved for the USB keyboard and USB Port 4 is reserved for 

the USB mouse.  

Micro USB type B 

DEX-100 provide 2 Micro USB type B port, and DEX-PRO SW use the front panel Micro USB port to 

send mouse and keyboard signal from DEX-100 to control the machine by the user during Full 

control mode or Data Extraction mode. So these 2 ports should connect to the machine PC’s USB 

port. 

Digital input connectors 

DIN2 is reserved to switch between the full control mode and data extraction mode. 

 

 

Fig.2-3 Digital input connector 



Left Panel IO for DEX-Pro application 

 
Fig.2-4 DEX-100 right panel IO for DEX-PRO application 

 

I/O connectors and controls reserved for DEX-PRO on right panel are as follows, 

  MPC VGA in port 

  MPC PS/2 mouse port 

  MPC PS/2 keyboard port 

MPC VGA in port 

DEX-PRO SW uses the MPC VGA port to connect with the machine’s PC and process the image from 

the HMI, and the MPC VGA out port should be always connect with the target machine’s PC for 

controlling and extracting the data from a machine with VGA monitor. This port should connect to 

the machine PC’ VGA port. 

MPC PS/2 mouse port 

DEX-PRO SW use the front panel MPC PS/2 mouse port to send mouse a signal from DEX-100 to 

control the machine by the user during Full control mode or Data Extraction mode. This port should 

connect to the machine PC’s PS/2 mouse port. 



MPC PS/2 keyboard port 

DEX-PRO SW use the front panel MPC PS/2 keyboard port to send mouse a signal from DEX-100 to 

control the machine by the user during Full control mode or Data Extraction mode. This port should 

connect to the machine PC’s PS/2 keyboard port. 

 

Right Panel IO for DEX-Pro application 

 

Fig.2-5 DEX-100 left panel IO for DEX-PRO application 

 

I/O connectors and controls reserved for DEX-PRO on left panel are as follows, 

  DVI out port 

  MPC DVI in port 

DVI out port 

DEX-PRO SW uses the DVI out port to display the bypass the image from the machine or the OP 

screen setup by the user, and the DVI out port should be always connect with the target machine’s 

monitor when controlling and extracting the data from a machine with DVI monitor. 



MPC DVI in port 

DEX-PRO SW uses the MP DVI port to connect with the machine’s PC and process the image from 

the HMI, and the MPC DVI out port should be always connect with the target machine’s PC for 

controlling and extracting the data from a machine with DVI monitor. This port should connect to 

the machine PC’ DVI port. 

 

2.2.3. Edit Stage connection example 

Below figure shows a typical connection example for the machine with PS2 KB, mouse and VGA 

monitor under Edit Stage.  

1. Connecting PS/ 2 Keyboard port, PS/ 2 Mouse port and VGA port on the DEX-100 right panel to 

the machine’s PC. 

2. Connecting VGA Out port on the front panel to the Machine’s PC display. 

3. Connecting the DP port on the front panel to a monitor to set-up DEX-Pro software. 

4. Connecting the one set USB Keyboard and USB mouse to USB port 1 and USB port 2 on the 

DEX-100 front panel to operate DEX-100. 

Note: You can also connect the PS/ 2 KB and mouse with the PS/ 2 mouse port and PS/ 2 Keyboard 

port on the front panel to control the machine under full control mode. 

 
Fig.2-6 Edit stage connection example 



2.2.4. Run time Stage connection example 

Below figure shows a typical connection example for the machine with PS2 KB, mouse and VGA 

monitor under Run Time stage. 

1. Connecting PS/ 2 Keyboard port, PS/ 2 Mouse port and VGA port on the DEX-100 right panel to 

the machine’s PC. 

2. Connect the PS/ 2 KB and mouse with the PS/ 2 mouse port and PS/ 2 Keyboard port on the 

front panel to control the machine under full control mode. 

 

 

Fig.2-7 Run time stage connection example 

 

 

2.3. Update DEX-Pro Utility 
This section provides instructions on how to update the DEX-Pro in your system. Prepare 

the DEX-100 SDK that comes with the package. 
 

 

1. Uninstall the DEX-PRO software in Windows as following figure. 



 

2. Reboot DEX-100. 

3. Execute setup file of DEX-100 SDK, and follow the Installation steps. 

4. When the installation window appears, click on the DEX-100 SDK installation button. 

 
5. When installation is complete, reboot DEX-100 

6. Launch DEX-Pro. 

 



2.4. Update DEX-Pro FW 
The following instructions show how to update the DEX-100 firmware in your system.  

1. Execute <Dex-Pro>\utility\BurnDex100_x64.exe 

2. Click Upload File and select bit file. 

 

3. When the update is completed, COLD RESTART Dex-100. 

 



2.5. Target Machine’s PC settings 
We have to turn off the target machine’s PC enhancement pointer precision to let mouse to be control smoothly. 

E.g. Windows 7 :  

  

 

 



 

  

Keep middle speed and disable 

Enhance pointer precision 



3. DEX-Pro Workspace & Menus 
The DEX-Pro interface includes the Menu bar, the Autorun Script panel, Config Script panel and Log panel. 

 

 

Reload OCR DB: Select this button to reload the library when the target path's library changes. 

 

Details of the elements are as follows. 

 

Group Component Panels Supported 

Auto Run  Run the script file automatically (HID time out/ 

digital input (DIN2)) 

Config Script Run the script file manually. Edit and test the 

script file 

Include the page identification editor 

Log Log the DEX-Pro event process time, e.g: Log the 

some script instruction of execution time 

 



3.1. Menu bar 

3.1.1. Files menu 

Contains functions for project file management. 

 

New  Create the script file 

Save file Save current script to the script file folder 

Load file Load current script from a script file folder 

Backup & Restore  

 DEX Pro Backup Backup the  

 Init file backup 

 OCR data base backup 

 Schedule file backup 

 Program backup 

 DEX Pro Restore Restore the 

 Init file backup 

 OCR data base backup 

 Schedule file backup 

 Backup Config Backup the  

 DDS/LOG Config 

 Modbus Config 

 Machineini  

 Page Definition 

 Replace Config Restore the  

 DDS/LOG Config 

 Modbus Config 

 Machineini  

 Page Definition 

Factory Restore Restore the files to factory-refresh state: 

 Init file restore 

 OCR data base restore 

Exit Close DEX-Pro Program 



   

Backup & Restore 

Backup and restore the DEX-Pro system described in this section. It divided two parts for backup and restore. One is the 

DEX Pro original configuration, script, OCR database on DEX Pro Backup/Restore and the other is DDS/REST, Modbus, 

Page identification, Log and machine initiation configurations on Backup/Replace Config. 

Dex Pro Backup 

There are four backup for DEX-Pro, and they are init file, OCR data base, schedule file, and program. 

 Init file 

It will copy shared.txt, OCR_M.ini, RCM_Auto.ini and RCM_Auto.lst files from “C:\_” and 

“C:\Users\iot64\Documents\” to “backup folder\Dex-Pro_backup\_” and “backup 

folder\Dex-Pro_backup\Documents” 

They are the setting from script initiation, item content, Asi-ocr configuration setting parameters 

 OCR data base 

It will copy the OCR data base templatefile.txt and TrainingData.bmp to “backup 

folder\Dex-Pro_backup\txt_db” 

 Schedule file 

It will copy the MSMQ Execute Scripts Management linked script to “backup 

folder\Dex-Pro_backup\spt” 

Note: It only backup the linked the script as follow picture 



 

 Program backup 

It will copy all files in “C:\Program Files\ADLINK\DEX-100\main” to “backup 

folder\Dex-Pro_backup\main” 

We show the backup function step by step as follows. 

1) FileBackup & RestoreDEX Pro Backup 

2) Choose backup category 

3) Choose which folder you will place the backup files and click “OK” 

  



 

 

Dex Pro Restore 

It is like the DEX Pro Backup, there are three restore for DEX-Pro, and they are init file, OCR data base, schedule file. 

 Init file 

It will restore shared.txt, OCR_M.ini, RCM_Auto.ini and RCM_Auto.lst files from “backup 

folder\Dex-Pro_backup\_” and “backup folder\Dex-Pro_backup\Documents” to “C:\_” and 

“C:\Users\iot64\Documents\RVM_Config” 

They are the setting from script initiation, item content, Asi-ocr configuration setting parameters 

 OCR data base 

It will restore the OCR data base templatefile.txt and TrainingData.bmp from “backup 

folder\Dex-Pro_backup\txt_db” 

 Schedule file 

It will copy the MSMQ Execute Scripts Management linked script from “backup 

folder\Dex-Pro_backup\spt” 



We show the backup function step by step as follows. 

1) FileBackup & RestoreDEX Pro Restore 

  

2) Choose restore category 

 

3) Choose which restored files folder and click “OK” 

 

4) Please restart the DEXPro  



 

Backup Config 

There are six xml configurations and one machine initial file on your system, we categorize five parts on these 

configuration.  

 DDS/REST configuration 

 Log configuration 

 Modbus configuration 

a) Modbus command configuration 

b) Modbus RTU configuration 

c) Modbus TCP configuration 

 Page Identification configuration 

 Machine initiation file 

So if you want to keep your xml configuration on your system, you need use this function to backup, and the backup 

files will be put on the Documents\RVM_Config folder. We will explain how to backup these configurations step by step 

as follow. 

1) FileBackup & RestoreBackup Config 

  

2) Click “Yes” to agree to backup 



 
3) Check the backup files folder 

 

Replace Config 

The same as Backup Config section, there are six xml configurations and one machine initial file on your system, 

we categorize five parts on these configuration.  

 DDS/REST configuration 

 Log configuration 

 Modbus configuration 

a) Modbus command configuration 

b) Modbus RTU configuration 

c) Modbus TCP configuration 



 Page Identification configuration 

 Machine initiation file 

If you want to restore your xml configuration on your system, you only use this function to restore, We will 

explain how to restore these configurations step by step as follow. 

1) FileBackup & RestoreReplace Config 

  

2) Click “Yes” to agree to restore 

 
3) Check the restored result 

 



 

 

4) Please restart the DEX-Pro 

Factory Restore 

“Factory Restore” can restore the Dex-Pro to the state which is just completely installed (factory-refresh). After 

you press the “Factory Restore”, there will show a message box to confirm that you really want to restore to the factory 

initial state. If you really want to restore to the factory-refresh state, click “Yes”. Otherwise click “No” to leave. 

 

 

 



 

After Restoring to the factory-refresh state, there will show a message to let you restart the Dex-Pro immediately. 

After restart the Dex-Pro, the state is at the state which is just installed. 

 

 

3.1.2. Tools menu 

DEX-Pro tools for configuration, OCR table and log settings 

 

Config See Config Menu 

OCR Table Management List the OCR Table value 

MSMQ Excecute Script 

Management 

MSMQ command list 

Hide Cursor in Remote Control 

Panel 

Hide local mouse cursor when using Remote Control Panel 

Disable Cursor Detection Enable/Disable Cursor Detection function 

Cursor Detection Re-Try 

Configuration 

Set the cursor detection retry times 

 



 

Tools 

Config menu 

Kill Switch Setting Set protection to prevent some functions  

MSMQ Set the MSMQ name and label 

Script Setting Script latency setting  

Background Schedule Setting Trigger the script by HID detection or timer 

Asi-OCR Advanced OCR parameter (Global parameter)  

Frame Grabber Setting DEX-100 Frame Grabber setting 

Configuration Management Setting (Include the DDS / REST module, Data filter) 

OP Screen Setting OP Screen optional setting 

OCR Mode Setting Switch OCR mode to Asi-OCR either Tesseract 

Tesseract OCR Setting Tesseract OCR Setting 

 Tesseract Model/Config Setting 

 Training Tool for Tesseract 

UWF Setting UWF related settings 

 



 

Asi-OCR Mode 

 
Tesseract Mode 

 

Kill Switch 

 

 



If the “Kill Swtich” setting is disabled, DEX-Pro remains operating as per normal. 

Otherwise, when “Kill Swtich” setting is enabled, then DI1 will have a new functionality as the “Kill 

Switch”, where: 

a. While DI1 circuit is closed (current applied between DI1 and COM), DEX-Pro shall remain 

operating as per normal. 

b. When D1 circuit is opened (open circuit between DI1 and COM), DEX-Pro must be “disabled” 

such that: 

i. Any scripts that are currently executing, either started by AutoRun mode, or Manual run, 

or started by MSMQ, or started by DI2, must be immediately stopped. 

ii. DEX-100’s control mode must be immediately switched back to “Full Operation Mode”  

iii. When the script is stopped in (i) and the Disconnect SptStatus message with is published 

by REST/DDS modules, the disconnect reason would be given a disconnect reason. 

iv. Any further attempts to start a script, either by AutoRun button, or Manual run button, or 

MSMQ trigger, or DI2 trigger, must be prevented. 

v. In case of attempts to start a script by AutoRun button or Manual run button, error 

message box with clear reason that DEX-Pro has been disabled by the Kill Switch. 

vi. In case of attempts to start a script by MSMQ trigger, error message with clear reason that 

DEX-Pro has been disabled by the Kill Switch, shall be returned to the host instead of the 

usual success message. 

vii. When DEX-Pro publishes out the SysMode message through REST/DDS modules, it shall 

publish using a new number as the “disabled” mode. This allows the host to identify that 

DEX-Pro has been disabled. 

viii. In case of attempts to read any register in DEX-Pro, such as by using MSMQ GetXXValue 

request, or by using REST/DDS MachineStatus request, an error with a clear reason 

message shall be returned to the host instead. This allows the host to identify that 

DEX-Pro has been disabled, and prevents the host from getting stale data. 

c. When D1 circuit is closed again, DEX-Pro operations shall be reverted to normal, such that 

scripts could be started like normal, and especially if a script is supposed to be started by the HID 

timeout feature, it shall be eventually started (HID timer countdown is reset when the D1 circuit is 

closed again). 



MSMQ Setting 

  

 

1) Target IP: The IP of target for DEX-100 sends message. Use 127.0.0.1 for sending a local message 

2) Queue: The specified queue to send and receive message 

3) Label: label can be blank or available to customers 

Script Setting 

  

 

1) Time Stop (ms):  



Base time to sleep after each script instruction is executed.  

※ Note: Base time the stop time required to multiply the scheduling instruction is the actual stop time of the 

scheduling instruction. So the sleep time is the Time Stop X Sleep, Time Stop is base time and Sleep of 

instruction setting is the multiple. It must uncheck the “DEX-Pro Speed Up” to enable this function. 

 

Default: 100. 

2) Spt Step Speed (ms): 

Time to wait in DEX-Pro program switch command.  

Default: 100 

3) DEX-Pro Minimized:  

The program will be minimized when DEX-Pro lunched. 

4) Saving Image Format: (It is used on command “Get bmp rect array”) 

Choose the saving image format for the full screen image  



Background Schedule Setting  

 

 

1) Script File: 

Path of the script file to run. 

2) Run script if HID keeps idling over timeout:  

Enable or disable auto-run script function. Script file will be launched when there is no keyboard or mouse input over 

timeout. 

3) HID idle timeout (sec):  

Timeout value in second for the mouse keeping not moving 

4) Auto run remind message timeout (sec):  

Timeout value in second for the screensaver 

 

 

Asi-OCR Tool  

You need to train the OCR result in advance with OCR_tool.exe 

Program path: C:\Program Files\ADLINK\DEX-100\main\OCR_tool.exe 

Please use OCR_tool.exe 

Click Tools->Set config 



 
1) Txt DB Config: Dictionary database configuration to identify the database location for text. 

 TXT File: Dictionary file files path. 

 Big Img File: Dictionary Chart path. 

 delete DB file: Delete the templatefile.txt and TrainingData.bmp 

 new distance: If checked, in debug view will be shown the blank when character has many blank lines 

distance to underscore  

 OCR Save Mode: 

i. No Save to db: If there is new character, it won’t save to word db 

ii. No Chk One: It doesn’t use the Asi-ocr pattern match function 

iii. No Chk More: It uses the Asi-ocr pattern match, but not match again for single character 

iv. No Use OCR: It doesn’t use the opencv ocr function 

v. make same high: Make the all images the same high and do preprocessing 

2) Blur: Color Range and Word Color Threshold are fine settings compare to the Back group color range and Later 

color threshold. 

3) Back group color range: Picture noise, picture to gray scale, adjacent point chromatic aberration is less than this 

value is white, greater than this value is black. 

4) Later color threshold: Picture chromatic aberration threshold percentage value, after the picture turns the gray 

scale, makes the color judgment to the black position; the larger the value retains the more black spots. 

5) Back Group Min rect (wxh): Picture minimum background range (width x height), the area within the range of 

chromatic aberration needs to be greater than this value before it is painted as a white black word. 

6) Minimum black grid: Minimum pixel number between two characters. It will treat there exists blanks when the 

pixel number of two characters larger than this value. 



7) Cut Word: Word split manner, normal way and precise way. 

a) Normal: It reflect the truly image, so it make every joined characters to a character 

b) Precise: Make every character a white space even if any two joined characters 

8) checksame: Identify the similarity; default to 1 reduces this value to improve the accuracy of the image when 

there is a distortion similar to the residual shadow. 

9) Char not indented: Check it, it will not remove the white space on character up and down. 

10) Word rect (W x H): Identify the width of the picture's threshold value, affect the use of the identification similarity, 

temporarily do not use. 

 

Asi-OCR v2.0: Asi OCR parameter Settings 

 

1) Txt DB Config: Dictionary database configuration to identify the database location for text. 

 TXT File: Dictionary file files path. 

 Big Img File: Dictionary Chart path. 

 Compute Checksum: This button will generate the checksum value from the selected TrainingData.bmp and 

store into the specific file. 

2) Background color range: Picture noise, picture to gray scale, adjacent point chromatic aberration is less than this 

value is white, greater than this value is black. 

3) Later color threshold: Picture chromatic aberration threshold percentage value, after the picture turns the gray 

scale, makes the color judgment to the black position; the larger the value retains the more black spots.   

4) Minimum blank pixels: the smallest blank pixel length between words and characters, and if the white space pixel 

length is greater than this value, it is treated as a space between words and words. 

5) Back Group Min rect (wxh): Picture minimum background range (width x height), the area within the range of 



chromatic aberration needs to be greater than this value before it is painted as a white black word.  

6) Similarity: identify the similarity; default to 1 reduces this value to improve the accuracy of the image when there 

is a distortion similar to the residual shadow.   

7) W x H: identify the width of the picture's threshold value, affect the use of the identification similarity, 

temporarily do not use. 

8) Debug: To turn on or off debug mode, to perform the relevant instructions for identifying pictures on open, and to 

store the information required for debugging. 

9) Color 1 ~ Color 4: Preset color identification settings, provide the purpose of color identification instructions 

10) OCR Save Mode: 

a) No Save to db: If there is new character, it won’t save to word db 

b) No Chk One: It doesn’t use the Asi-ocr pattern match function 

c) No Chk More: It uses the Asi-ocr pattern match, but not match again for single character 

d) No Use OCR: It doesn’t use the opencv ocr function 

e) make same high: Make the all images the same high and do preprocessing 

f) Adlink table: Force the OCR result to replace to the format character (N, L, l, W) 

11) Cut Word: 

a) Normal: It reflect the truly image, so it make every joined characters to a character 

b) Precise: Make every character a white space even if any two joined characters 

12) Char not indented: Check it, it will not remove the white space on character up and down 

 

Re-read glyph database 

 

 

Set the configuration archive 

 



 

 

 

 

Train OCR data 

Tools>Correction 

Tool separate OCR ROI as single file 

ROI1 is “2047480”, it’s separated as serval files. 

The result of first files is “2”. Correct! 



 

 

 

 

ROI1 is “2047480”, it’s separated as serval files. 

The result of second files is “Q”. Incorrect! 

It should be filled “0” into textbox and click change. 

ROI1 is “2047480”, it’s separated as serval files. 

The result of 4th files is “d”. Incorrect! 

It should be filled “74” into textbox and click change. 

Sometimes, the result will be identified as multi-words 



 

 

 

 

After train the OCR result, make sure Reload DB and Set Config 

Tools>Config>Asi-OCRv2.0 

Send OCR again, you can see the correct OCR result 



Frame Grabber Setting Panel 

  
1) Auto: 

Enable or disable auto-detection of input resolution for video source. Auto-detection may fail when video signal is not 

analyzable for DEX-Pro; manually select the resolution is need in this case. 

2) Fixed: 

When video signal is not analyzable for DEX-Pro, you can check the “Fixed” and choose the best resolution for your 

machine. 

3) Source:  

Select VGA or DVI input. 

4) Resolution: 

Support resolutions list for manual selection. 

5) Save Source Input: 

Confirm frame grabber setting on “Auto” or “Fixed” mode. 



Configuration management  

  

 

DDS OCR configuration Define the machine status table  

Page identification Define the page description  

Data Filter Data Table filtering 

Modbus configuration Modbus setting form 

FTP Management FTP setting form  

 

DDS & REST OCR Configuration 

The properties also include a description for each ROI so the Data grid will be able to display the ROI and Datatype, 

Description together with the setting. Whenever a ROI is selected in the Data grid then the configuration of the ROI will 

be displayed under the Data Configuration in a separate ROI index. 

The image layer and ROI rectangle corresponding to selected item will be displayed on the right-hand side panel. 

Before display the ROI rectangle on the panel, it requires to load image layer in main program. 

 



Use the Communication Module Configuration menu to set the Machine Configuration group box (include the 

host name/port number), and the Communication Module Configuration group box. 

 

Machine Configuration 

1) Module: This selection let you choose the sending module. 
2) Host Name: Destination of the receiver’s IP. 
3) Port: Destination of the receiver’s port. 
4) Machine ID: Current DEX-Pro’s present ID. 
5) Machine Name: Current DEX-Pro’s present name. 

After all the setting are completed, press “Modify and Save” to store the settings. 
 

Data Configuration 

Select the row in the table can let you edit the properties in this part. 

1) Upload ROI: If checked “Yes”, the ROI column of this row will be set to Ture(send); otherwise will set to False (not 
send). 

2) Data Type: This data type denotes to the data user wants to send. 
3) Description: The additional description of this data item. 
4) Page: The page of this item. 

After all the setting are completed, press “Modify and Save” to store the settings. 
 

Update Multiple ROI 

This magic sugar is designed for user to multi-select the upload ROI item. 

1) Upload ROI: If checked “Yes”, the ROI column of this row will be set to Ture(send); otherwise will set to False (not 
send). 

2) item: this index let you group changing the property of Upload ROI. 

After all the setting are completed, press “Save to items”. 
Run DDS/Stop DDS let you start or stop the DDS program locally. Same as REST, Run REST/Stop REST let you start 

or stop the REST program locally. The two check box, DDS module auto-run and REST module auto-run, let the DDS and 
REST can automatically locally start when DEX-Pro started. 
 



Table 

 

1) ROI: You can select whether ROI index of result for posting and have to also mapping the ROI index used in the 

script file editor. 

2) Data Type: Define the ROI data type (uint string, or others) 

3) Description: Define the description of ROI. SQL table schemas are created by this parameters. Description of 

Items must not be duplicated. 

 

Click the “Save Table Schema button” (It will generate the config, xml for restful module) 

 

<?xml version="1.0" encoding="UTF-8"?> 

<DES> 

    <TableSchema> 

        <machine_id>2</machine_id> 

        <length>5</length> 

        <datatypes>u8,u8,u16,u32,str</datatypes> 

        <descriptors>1Complete_PWB,2Attempted_Pickup,3Missed_Pickup_Errors,4TEST,5tst</descriptors> 

    </TableSchema> 

</DES> 

Then Open the restful module (Click the “Run REST module” button). 

Finally run you script instruction to let the machine status data continuously. 

 

In this RESTFUL module section for the post data function, you can find the general steps for machine status 

transmission. 

 



If we editor the script file already. The Script file gives you options to configuration OCR data. Please check the 

instruction as following  

 

Instruction Name: MSG SAVE TABLE TO LOG 

Parameter:  

 default X =0 

 H = 1 (Machine status will post to edge-server by restful or DDS module) 

 Text (For example: 1~7. Use this option to save the machine status data to array. The number indicate the index od 

ROI. It also save the log on local machine. 

 Tool  Config  Config Management  DDS OCR Configuration 

 

 

Page identification 

The page identify function can tag the target machine image by one or more pattern. The detail of description are 

described in section 6. The page configuration editor allows you to define the alarm code number for a specified alarm 

page. For a warning page, warning message and warning number can be defined. When VGA/DVI inputs are recognizied 

with page id successfully, these page information will be extracted and uploaded to database. 

 



 
 

Page Type: define which type the page is 

 Normal: normal page 

 Warning: warning page 

 Alarm: alarm page 

 Other: reserved, no use 

Major Code: The major code number for an alarm page 

Minor Code: The minor code number for an alarm page 

Message Number: The warning message number for warning page 

Description: Message for warning page. 

Set the Page Configuration: set Page Type, Major Code, Minor Code, Message Number, Description to selected page. 

Rectangle: load location information of warning image from configuration. 

Save Page Identification Configuration: save configuration to file. 

 



 

Update Rate (sec): The rate to upload waning/alarm information. 

Set the Warning/Alarm update rate: save rate to config file. 

 

FTP Management 

 

Using an FTP client is a method to upload, download, and manage files on our server. Dex-pro provides ftp client 

functions, such as uploading files (logs).  You will need the following FTP login details to access your FTP account 

through an FTP program:  

1) Server IP (host): the FTP server IP 

2) Username/Password: account & password to login FTP server 

3) Click the “Apply” button: save the FTP username and password 



4) FTP Upload: Select the log you want to upload (Machine Status/Warning Message/Alarm Message) 

 

User Scenario 

1. Using the instruction command”MSG_SAVE_TABLE_TO_LOG” then setting the jsonlog file. 

2. Setting the “Machine Status (OCR)” enable. 

3. The json file will upload to the FTP server. The server file default path is “home/machine id/” (Note1). 

 

Note1: Use the Communication Module Configuration menu to set the Machine Configuration group box (include the 

machine id) 

 

Note2: The local log file default log path are shown as following  

 “C:\Program Files\ADLINK\Dex-100\main\Dex-100\LogJson\MachineStatusLog” 

 “C:\Program Files\ADLINK\Dex-100\main\Dex-100\LogJson\WarningLog” 

 “C:\Program Files\ADLINK\Dex-100\main\Dex-100\LogJson\AlarmLog” 

Note3: The FTP client only uploads the json log file. (Xml does not support) 

Data Filter  

Tool  Configuration Management  Configuration Management  Data Filter 

Main Program provide the Data Filter form for OCR data parsing/replace 

Initial file: logXML.xml 

<?xml version="1.0" standalone="yes"?> 

<DES> 

  <Filter> 

    <Replace>False</Replace> 

    <ReplaceStr /> 

    <Type>NONE</Type> 

    <StringContain>1</StringContain> 

  </Filter> 

</DES> 



 
Replace Status 

you can choose whether to turn on the function (False or True) of replacing the string, or use Regex instead of the string. 

The following will briefly introduce the function of replacing the string. 

Replace String  

First, we can replace multiple strings (Enable the function: True or False) 

Second, If the original data string is” Inspection: 2.0sec”. Then the information we expect is the number “2.0”. 

E.g.: ROI item: Inspection: 2.0sec 

 Set the replace status is “True”.  

 Set the Replace String is Inspection:,sec (Note1)then click “Modify and Save” button. The configuration are save in 

the XML file as following 

<ReplaceStr>Inspection:,sec</ReplaceStr> 

 

Note1:"," is the spilt char 

The replace results are shown as following 

Result: 2.0 

If the replace function is error. It will return the "error" string 

 

We can put the regex string to the <ReplaceStr> 

E.g.: If we replace the "," "." Then we also can set the parameter [,] [.] 

 

If we need to determine whether the result is correct, we can add the check type feature to determine whether it is a 



string or a number. For example, the result of our replacement string is “2.” (ocr recognition error) 

Check Type  

We can check the ocr results of data. If the ocr item is integer/double etc. 

Then set the <Type> : NONE , InNumber , IsString. In this example we set the type is: “InNumber”. However, the result 

will be judged that the value is not a legitimate number, so it will be returned 0.0  

 

E.g.: ROI item : 2.x9  or df345$x are non-illegal (Check Number: return 0.0) 

E.g.: If ROI item is string (Ready/Running are also correctly). However, we can set the parameter on <StringContain> = 

Ready|Running 

 

 

We can use the more advanced string comparison function to determine whether the string meets our expectations 

String/Regex String 

It can accept the regex string.  

E.g.: If we want to check the string are illegal or not. Expected result format is “5205310-A01-B” (seven numbers – 

alphabet two numbers – alphabet) 

 , we can set the parameter to be REGEX string:  “^[\d]{7}-[A-Z]{1}[\d]{2}-[A-Z]{1}&” 

 

 

However, we can also using the filter instruction 

 

 

 

Filter data by string or regex string 

 

If the text string less than 1: replace the string empty 



The Text string are split by “TAB” 

 

Ex: x=1 , Text: sec 

It will replace the string “sec” to “” string empty 

 

Modbus configuration 

Main Program support I/O operations on connected Modbus devices. We can set Modus devices and I/O commands in 

the configuration pages.  

 

Set Devices Set the Modbus TCP/RTU device for the connection 

Set Commands Set the Command for the script editor using 

 

[Set Devices] 

 

Fig 3.1.Set Device (TCP) 

 



 

Fig 3.2.Set Device (RTU) 

 

The modbus configuration provides the “Add Device”, “Delete Device” and “Update Device”. 

1) Add Device: Add the modbus configuration mapping to real modbus device 

2) Delete Device: Delete the modbus configuration which it may be invalid 

3) Update Device: Update the modbus configuration for single device information 

We explain what modbus information you need as follows: 

 TCP Device 

  IP: IP address of the device 

  Port: Port number of the device 

  Slave ID: A unique device id to identify the device 

 RTU Device 

  COM: COM port number of the device 

  Baud Rate: Baud rate of the device 

  Data bit: the data bit of the device 

  Parity: the parity of the device 

  Stop bit: the stop bit of the device. Note: stop bit has to be 2. 

Slave ID: A unique device id to identify the device 

 

 

 

 



[Set Commands] 

 

Fig 3.3.Set Commands 

In the Command setting page, we need to choose a target device by specifying device id and Modbus function code and 

related arguments. We support function code 1, 2, 3, 4, 5, 6,15,16. 

FC 1,2,3,4 are reading function, only set the “Data Type”, “Start Address”, “Length” and “Description” 

FC 5,6,15,16 are writing function, set the “Data Type”, “Start Address”, “Length” and “Description” to define the 

Command, and input the writing value in Script Editor  

We explain what command information you need as follows: 

1) Select Devices: select what device you need to get/set value 

2) Function(FC): Provide FC1,2,3,4,5,6,15,16 

 FC1: Read Coil Status (Read Bits) 

 FC2: Read Input Status (Read Input Bits) 

 FC3: Read Holding Registers (Read Registers) 

 FC4: Read Input Registers 

 FC5: Force Single Coil (Write Single Bit) 

 FC6: Preset Single Register (Write Single Register) 

 FC15: Force Multiple Coils (Write Multiple Bits) 

 FC16: Preset Multiple Registers (Write Multiple Registers) 

3) Data Type: Provide the 5 data types 

 UINT8: Single Bit Value 

 UINT16: Single Register Value (16bit positive integer) 

 UINT32: Double Register Value (32bit positive integer) 



 INT16: Single Register Value supported negative value (15 bit positive/negative integer) 

 INT32: Double Register Value supported negative value (31 bit positive/negative integer) 

 FLOAT32: Single Double Precise Value 

4) Start Address: Read/Write value from the first address 

5) Length:  

 FC1,2,15 number of bits 

 FC3,4,16 number of registers (UINT16/INT16) or double-registers (UINT32/INT32/FLOAT32) 

6) Description: describe the content for this command, for example, light switch (ON/OFF) 

Fig. 3.3shows a command with function code 1, reading ON/OFF status starting from address 0 for 1 bit of length. Fig. 

3.4shows how to edit script and Fig.3.5shows edit a command with function code 15, writing ON/OFF status starting 

from address 0 for 5 bit of length. 

 

 
Fig 3.4.Edit script 

 



 

Fig 3.5.Writing Command on Script Editor 

 

 

OP Screen Setting 

 

Tools  Config  OP Screen Setting. 

In OP Screen setting including a selection of interested pages displayed on OP Screen and it label. We can select at most 

five interested pages to be displayed on OP Screen in runtime mode. The Page ID can be assigned in the top-left area of 

setting panel. The label also can be edited and displayed on OP screen. 



 

 

1) Frame Interval (ms):  

Time period to sleep between output frames  to OP-Screen. 

2) Max warning images displayed:  

In order to avoid warning / alarm pop out windows too many, you can set the maximum number of overlapping 

windows in the op screen. The maximum number of warning images can be displayed on OP-Screen. The detail of pop 

out windows setting are shown in section7.5. 

In runtime mode, the op screen will show the interested pages.  

 

Select the interested 

page by set Page ID to 

Host View 

Edit the label for selected 

pages



 

OP Screen Local Mode 

Local Mode allows users to view and edit local applications (at most two) with OP-Screen. When Local Mode is entered, 

selected applications will be run in virtual desktop environment and users can operate them within the environment.  

 

 Switch to APP Desktop by receiving MSMQ message “SwitchMirrorDesktop”: 

“SwitchMirrorDesktop” is a DEX100 MSMQ message reserved keyword. If DEX100 receives the MSMQ command 

and enable local mode, it will switch to APP Desktop in the OP mode. For more DEX100 MSMQ message 

management information, please refer the topic “MSMQ Execute Script Management” in this chapter. 

 

 Configuration: 

a) Windows: Settings  Multitasking  Virtual desktops 

Set options “On the taskbar, show windows that are open on” and “Pressing Alt+Tab” shows windows that are open 

on” to “Only the desktop I’m using”. 

Select Host View you want and view OCR result at Data Summary. 

Or leave and stop script by clicking Full Operation



 
 

b) Set Dex-100 Screen Resolution the same as target Host machine. 

 
 

c) Dex-Pro: Tools  Config  OP Screen Setting  Mirror Local Application 



 

 Process Path 1: Full path for application 1 to be operated. 

 Process Path 2: Full path for application 2 to be operated. 

 Button Label: The text of button for Local Mode. 

 Frame Interval (ms): Interval between frames for Local Mode.  

 

d) Modify script instruction, setting Q=2 in Connect to enable Local Mode. 

 

 

Usage: 

a) Enter Local Mode: Click bottom-right button on OP-Screen panel (e.g., Notepad)  



 

 

b) Local Mode: the virtual desktop operation environment will be displayed. User can click Return Icon located in 

right-bottom (or F12) to exit Local Mode. 

 

 

Note 

a) To avoid impacts on Dex-100 system, the following keys and combinations are disabled in Local Mode: 

Win Key, F1-F10, PAUSE(BREAK), CTRL+ALT+DELETE, CTRL+ESC, CTRL+SHIFT+ESC. 

 

b) To avoid impacts on Dex-100 system, desktop icons, Windows Start Menu and system tray are hided automatically 

when Local Mode entered. Manually setting is required to keep NO applications pinned to taskbar and turn off 



Cortana, People buttons and etc. 

 

c) Hot-Key for click OP panel buttons 

F11: Full Operation, switch to full control mode. 

F12: Return Icon, switch to OP panel. 

 

d) Do NOT use keyboards with special hot-keys.  

 

OCR Mode Setting 

User can set the OCR mode to either Asi-OCR or Tesseract. See more detail in 6.9. 

 

OCR Mode = 0 : using Asi-OCR 

OCR Mode = 1 : using Tesseract  

(with O/0 post processing improve the O and 0 recognition, but it has to trained the O and 0 picture 

first) 

OCR Mode = 2 : using User-defined OCR 

 

If the OCR Mode using Tesseract, there will show additional detail settings “Tesseract OCR 

Setting->Model and Config Management”. See more detail in 6.9. 



 

UWF Setting 

UWF related setting. More detail can see in section 7.8. 

 

OCR table management 

This function lists the value for whole OCR table. 

 

Click “Reload”, the OCR data will be 

reloaded the newest data 



MSMQ Execute Script Management 

Script mapping the command 

Provide MSMQ Script Management 

 One message mapping the one script  

 We can insert the data by using the "key in" instruction   

 MSMQ message reserved keyword:  

 “SwitchMirrorDesktop” 

Please refer the topic “OP Screen Local Mode” in this chapter. You can redefine the action by yourself here, 

but it is not recommended 

 “EAPStopCommand” 

This command can stop the running script that is called by MSMQ or autorun. 

 

 

1) MSMQ Cmd: Select MSMQ instruction. 

2) Control PC: Choose a connected extractor. 

3) Scripts File: Schedule to be collocated. 

4) Change: Save the modified changes. 

5) OK: Save editing settings, please restart the program, the profile will be re-loaded to complete the set. 



Hide Cursor in Remote Control Panel 

In remote control panel, you can control remote machine cursor with DEX-100 mouse. The remote 

cursor will move the position where Dex-100 cursor located, and both cursors will be displayed, 

shown as the figure below. When “Hide Cursor in Remote Control Panel” is enabled, only remote 

cursor will be displayed, as the next figure below.  

 

Both cursors of Dex-100 and remote are displayed 



 
 

Disable Cursor Detection 

This function is global setting for cursor detection enable/disable. If your mouse command already set cursor detection 

enable, we provide the global setting to disable the cursor detection. E.g. Left click: the W parameter is set 1 and Right 

click: the W parameter is set 1, too. We can check “Disable Cursor Detection”, and the cursor detection function is 

ignored. Otherwise, if we uncheck “Disable Cursor Detection”, the system will follow the command scope setting to 

operate. It is showed as follows. 

Only remote cursor is displayed 



 

 

 

Enable this “Left click” command to cursor 

detection 

Enable this “Right click” command to cursor 

detection 

Disable all commands cursor detection 



Cursor Detection Re-Try Configuration 

This function is setting the re-try times when cursor losing tracing happens. The re-try times represent the re-trace the 

machine cursor times. (The default value is 3) If it is over the re-try times and it is still not correct, it will show message 

box to alarm in DEX-Pro. It will happen on status 1, 2 and 7 showed table on Section 6.6.6. 

 

3.1.3. Help menu 

About DEX-Pro Version information 

 

This dialog contains detailed version information for the DEX-Pro itself as well as detailed version 

information for all referenced assemblies.  

 

 

3.2. Quick Menu 

3.2.1. Reload OCR DB (AsiOCR Only) 

Reload OCR Txt DB from text file and Big Image File. Default text and big image will be 

templatefile.txt and TrainingData.bmp respectively. DB can be set in Asi-OCR config. 



3.2.2. DI Status 

Provide the DI1 and DI2 ON/OFF status. 

 

3.3. Tab Menu 

3.3.1. Auto-run Script panel 

When the script is first started, it automatically detects any compliant trigger source. The script file will trigger by digital 

input (DIN2)/ hid time out/ msmq command. 

 

Button description 

Start (Auto):  Start script, set in background schedule setting. 

Stop(Auto): Stop script 

Draw Image (On) Display remote screen enable 

Draw Image (Off). Display remote screen disable 

 



Running Script Panel 

 

Fig3.2.2 

When the schedule is executed, an action to execute the schedule will be displayed on this page. 

At the beginning of the execution, the schedule edit page and the LOG page cannot be operated, and the Stop button 

(illustrated by blue rectangle in Fig3.2.2) is for stopping the automatic schedule. The top left buttons named end with 

“(Auto)” is to control the schedule, and the currently executing schedule will be highlighted. 

 

MSMQ Panel 

When Dex-Pro receives a message from MSMQ, the received message and associated script will be 

displayed on the MSMQ panel. The panel can display up to 100 messages, more detailed will be 

stored in log file (“C:\Program Files\ADLINK\Dex-100\main\Dex-100\logs\logfile.txt”). 



 

Running image panel 

The right side of the remote computer's real-time image, you can see the page to control the 

operation when Draw Image is on. 



 

 

3.3.2. Config Script panel 

Remote Control Pane Current target machine screen 

Screen Capture Pane Editor for OCR selection 

Page Identify Pane Editor for Page Identify 

 

 
 

Remote Control panel 

The basic functionality for the connect button is to be able to either capture image.  

If acquisition has already been started then this button will wait for the next image from the grabber. The disconnect 

button will call the acquisition inside the grabber is stopped by executing the “AcquisitionStop” function. 

 

Scenario Description 

 If we want to control the target machine by mouse (Please click the “Control button”)  



 

If we need to be saved image to disk then select the “Snapshot” button. This will save the image getimg_001, 

getimg_002.....getimg_00N in the script file folder. (Path: Your script file folder) 

 

Note: Need to click the “Select” button to select your folder or create new folder 

 

Fig 3.2.3 

Screen Control panel 

 

Fig 3.2.4 Script edit pane 



In this screen to do the compilation and testing of the action, the following is the function of the key instructions:  

Left side Pane 

1) Connect: Equipment connection, the machine can see the picture on the right. 

2) Disconnect: The device ends the connection. 

3) Control: after connection, you can control the console. 

4) View: after you are online, you cannot control the console; only view the screen of the machine. 

5) Sleep to Next: set the wait time between directives 

6) Path: Set the path to the storage disk case and use it when you need to go online to the computer. 

7) Snapshot: after online, retrieve the screen of the machine, save as BMP file 

8) Load Img: load picture, display to the right of picture 

9) Save Scripts: Store the schedule in the current edit 

10) Run Scripts:  Use file  load File , Reading SPT after file, use this button to perform a schedule 

11) Stop Scripts:  Use this button to break execution scheduling when executing a schedule 

After the click of the scheduling instruction, the order of the instructions can be modified by the  

 

 Component of the upper and lower key.   

 

Fig 3.2.5 Script Edit functional button 

 

Click on the specified screen or schedule command: Press the up and down arrow keys to switch the order of 

commands / screens. 

 

 In order to set the common instructions for scheduling, click to set the instructions to the scheduling 

 
Fig 3.2.6 Absolute position for the mouse 

 

When setting the mouse on the picture, the mouse click position (X_Y) or frame selection range (W_H) is displayed. 

 

 To the right for editing the scheduling, commonly used functions: 

 

Fig 3.2.7 KB and mouse functional button 

 



Set the schedule of commonly used instructions: 

Click to set the command to schedule 

 

 OCR identified as text, the common follow-up approach: 

 

Fig 3.2.8 OCR Identification function pane 

 OCR Identification directives:  

 

Table field: When the point is selected to the identification picture instruction, the number of the identification frame is 

displayed.  

 

Mode Identification mode: Select the identification mode is not All ( the following figure ) , the instruction needs to be 

compared to the text after the identification, the input is more than the text by pressing ADD OCR can set instructions 

to a schedule. 

 

 

Fig 3.2.9 OCR Mode Selection 

 

OCR Mode for the options are described below:  

1) All: After the text is recognized, no literal alignment is performed. Multiple data can be identified at one 

time, the left mouse button box to select the range of identification, press ADD OCR. You can add 

instructions to the queue  

2) Check Text: After identifying the text, make the text comparison. Enter the name of the text pair in the input 



field above the Add OCR. After entering text, press add OCR to add instructions to the schedule  

3) Multi-Character Format: Define character type for every character one by one in “Format”. 

4) Check Text from Table: Compare the identified text from ROI with Table item. Enter the item number in the 

textbox, press add OCR to add instructions to script. Instructions “Get bmp rect”, “Send OCR” and “Table 

Compare” will be added to script. 

5) Check Text from File: Compare the identified text from ROI with input from specified file. Enter the file path 

in the textbox, press add OCR to add instructions to script. Instructions “Get bmp rect”, “Send OCR” and 

“Table Compare” will be added to script. 

OCR Type: Select the type of OCR. 

 

Fig 3.2.10 OCR Type Selection 

 

1) All: normal ocr. 

2) Alpha: The ROI will be recognized as alphabet text. 

3) Upper Alpha: The ROI will be recognized as alphabet text with upper case. 

4) Lower Alpha: The ROI will be recognized as alphabet text with lower case. 

5) Digit: The ROI will be recognized as numbers. 

 

Format: Define character type for every character one by one, and the character format type is as follow: 

1) A: all 

2) N: Number 

3) L: Uppercase letter 

4) l: Lowercase letter 

5) W: Uppercase and Lowercase letter 

 

 OCR Identification Test: 

 
 

Fig 3.2.10 OCR Test 

OCR Test provides a quick OCR identification for a selected ROI. Select ROI and press “Send OCR” than the OCR result 



will be displayed. For example, the ROI was recognized as “0”. OCR Type is able to be specified by selecting the type. 

Page Identify panel 

 

Fig 3.2.9 Page Identify Editor 

 

The Page Identify Editor is for selecting and setting patterns to define page id and warning images. 

 

 Page Define Pattern 



 

Fig 3.2.10 Page Identification panel 

 

Edit  

X: The selected pattern’s x position, must be a multiple of 16. 

Y: The selected pattern’s y position, must be a multiple of 2. 

Width: The selected pattern’s width, must be a multiple of 16. 

Height: The selected pattern’s height, must be a multiple of 2. 

Threshold: The threshold for selected pattern. Suggest Value: 100. 

Clear all ROI: Remove all pattern. 

Delete ROI: Remove selected pattern. 

 

Page Define Pattern: When this item is checked, the dragged ROI is used as page-identify pattern. 

Select Warning/Alarm Image: When this item is checked, the dragged ROI is used as a warning image. 

Update Page Image & Threshold: Based on current target screen, re-calculate the comparison threshold of the page’s 

pattern and save it. 

Load Config: load page identify config file from the working Path. 

Save Config: save page identify config in the working Path. 

Auto Load Config File: Auto-load page identify config file when Dex-Pro main program is lunched. 

Show Crop Pattern Image: Display the selected pattern. 

 

 Warning/Alarm Image Clip 

 



 

Fig 3.2.10 Warning/Alarm image panel 

 

X: The selected image’s x position, must be a multiple of 16. 

Y: The selected image’s y position, must be a multiple of 2. 

Width: The selected image’s width, must be a multiple of 16. 

Height: The selected image’s height, must be a multiple of 2. 

Clear Warning/Alarm Image: Remove selected Warning/Alarm Image. 

 

 

3.3.3. Log panel 

 

Record the operation of the action and MSMQ message delivery, Tools  Log Setting can be set to store the number of 

days, click Search Log File can look for the previous record. 

 



Log function button 

Load log file  Log execution and run time log 

Reload Log file Reload the run time log (by date)   

Log Setting Settings of Log 

 

Log Setting  

The log files keeping days 

Path:  

C:\Users\user\Documents\RCM_TABLE_LOG  

C:\Users\user\Documents\RVM_LOG 

 
 

1) Use Window Event Log:  

Check the log stored in the system event book, if there is no check will save the text file on the folder. 

 

2) Keep Log File (Day):  

Use Window Event Log is not ticked, that is saved as a text file, and can set the number of days to save. 

  



4. OCR Tool Workspace & Menus (AsiOCR 

only) 
The OCR tool performs optical character recognition (OCR), a process that verifies the characters in one or more 

character strings match the characters you expect in each acquired image. When you test in OCR tool, you specify the 

number of strings you want to verify and the characters they should contain. The OCR tool path is in C:\Program 

Files\ADLINK\DEX-100\main. 

4.1. Menu bar 

 

4.1.1. Files Menu 

Exit Exit program 



4.1.2. Tools Menu 

 

Set Config Set the global OCR parameter 

OCR Debug Enable OCR Debug  

Adjust Color Variation Debug the parameter 

Correction Define the character definition  

Set Config 

 

Set the OCR parameters. Parameters are described in section 3.1.2, see Asi-OCR Tool Panel. 

OCR Debug 

Click ToolsOCR Debug and click the debug button or  



 

 

click Set ConfigCheck debugClick Set button and click debug button  

to open the OCR Debug 

P.S. If you want to preview the OCR results, you can step by step as followings: 

1. Click “Add” or “Add Path” 

2. Click “Split All to Tempfile” (You can also input the character format {W, L, l, N} on the right 

textbox) 

And the results are shown on the OCR column 



 

 

1 

2 



 

 



 

 
A Panel to browse OCR_Later images. 



Adjust Color Variation 

   

 

The tool supports a tuning feature that allows it to generate a good set of search parameters, for identifying individual 

characters in the string.  

 

Follow the steps to correct OCR result or construct OCR database: 

1. File Path：Load Picture, picture will be loaded and displayed. 

2. Press “Split Picture”. Apply OCR to loaded picture. 

3. The OCR result will be showed on textbox. 

4. If the result is incorrect, modify the result. 

5. Press “Change DB” to save result. 

7. Press “Split Picture” again, it shows the corrected result. 

You may need to reload OCR DB in main program after correction. 

 

Character strings that can be successfully analyzed with an OCR tool typically share most of the following characteristics: 



Clear Image, the image contains sharp character edges. 

 

We can use the three parameters for tuning the ROI image 

For example: Different ROI Group using different ROI parameter 

 Background color range 

 Later Color threshold 

 Similarity 

 

The target machine’s script group has 3 ROI group.  It is possible to separate the ROI group from script file. 

However we provide more type of parameter for different group of ROI. 

Group1  

Background color range:50 

Later Color threshold: 30 

Similarity(chksame):0.8 

 

 

Group2  

Background color range:50 

Later Color threshold: 30 

Similarity(chksame):0.8  

 

Group3  

Background color range:120 

Later Color threshold:47 

Similarity(chksame) :0.7 

 

 

 

Group4  

Background color range:120 

Later Color threshold:40 

Similarity (chksame):0.8 
 

 

By using the Color Variation and Threshold, the character will split the background color and word color  

If you would like to check the every process for the character handling, you can click the “show bug img” to see the 

every image processes. The image processes could provide you more information on character changing and adjust the 

better parameters.  

 



Correction 

Using an OCR tool to analyze a character string with potentially difficult characteristics is possible with the right 

configuration parameters. 

 

 

Correction function will load two configuration file templatefile.txt/ TrainingData.bmp 

We can watch the character results by the tool. If the character result is wrong, we can revise the character definition 

(click the “change button”)  



 

Even after tuning, an OCR tool can still fail to verify a couple of characters in the string. 

By similarity threshold for individual character parameters (Tool -> Set Config -> Similarity), it can improve the 

recognition rate. 

Arrange: Reload the DB and deleting character bmp file not reserved in the DB 

Delete: Delete the selected character bmp file  

Late Info: Show the character width and height and the character in DB position (Higth and Width line) and the total the 

same character counts 

Character Format: 

 0-None: No character format 

 1-Number: The character is the number format 

 2-Uppercase Letter: The character is the Uppercase Letter format 

 4-Lower case Letter: The character is the Lowercase Letter format 

For the detailed description, please refer to section 7.2 Asi OCR Training 

  



5. Script Command 

5.1. Script rules 
1. Only one script can run at the same time. 

2. Some of script instructions need to execute “Connect”, please refer section 5.2 

3. In a script, the last command must be “Disconnect”. 

4. The script executor priority table: (“MSMQ Execute Script” please refer section 7.4) 

 

Running Script \ Interrupt Script AutoRun Script 
MSMQ Execute 

Script 

Manual Execute 

Script 

Digital input 

(DIN2) Trigger 

Script 

AutoRun Script 
Overwrite 

running script 

Overwrite 

running script 

Overwrite 

running script 

Overwrite 

running script 

MSMQ Execute Script 
Skip Interrupt 

Script 

Overwrite 

running script 

Overwrite 

running script 

Overwrite 

running script 

Manual Execute Script 

Skip Interrupt 

Script 

Skip Interrupt 

Script 
X 

Overwrite 

running script 

Digital input (DIN2) Trigger 

Script  

Skip Interrupt 

Script 

Skip Interrupt 

Script 

Skip Interrupt 

Script 

Overwrite 

running script 

 

5.2. Script Instruction Description 
Instruction Category 

1) Communication Function 

2) Script Control 

3) Page Identification 

4) Data Processing 

5) OCR Function 

6) Mouse Action 

7) Keyboard Action 

 

Some of instructions need to execute “Connect” first, you can check the following table. 



Instruction Table 

# Category Instruction Name Description Connect Necessary 

1 Communication Connect 

Should able to start capturing the source 

signal and run script 

 

W: frame numbers to skip in multipage 

mode.  

H: Page Mode 

  0: No Page Identify 

  1: page identify with multiple pages  

  2: page identify with single page 

3: page identify with single page or 

multiple pages (Auto-Recommend) 

Q: OP Screen Mode 

  0: off  

  1: on   

  2: on (Local Mode) 

No 

2 Communication Disconnect 
Should able to stop capturing the source 

signal and stop script 
Yes 

3 Communication DI ReadLine 

Read digital input. 

 

X: line number of digital input 

Y: if DI ==0 +x: goto previous step, 0: go to 

end; -x go to next steps 

W: if DI ==1 +x: goto previous step, 0: go 

to end; -x go to next steps 

 

No 

4 Communication LED Control 

Set the LED On/OFF 

 

X:number of the LED, EX:LED_U1, please 

input 1 

Y:ON/OFF status 

 0:OFF 

 1:ON 

No 

5 Communication 
Get Modbus IO 

Status 

Read value to modbus device  

 

Modbus CMD: predefined Modbus read 

command 

No 



Items: items to store read value 

6 Communication 
Set Modbus IO 

Status 

Set value to modbus device  

 

Modbus CMD: predefined Modbus write 

command Values: value to write 

No 

7 Communication show EAP Log 

Send Message to private queue with 

MSMQ. The name of private queue can be 

set in MSMQ Setting. 

 

Text: message to sent 

No 

8 Script Control Go to  

Jump to a specified script instruction.  

 

X: number of instructions to jump 

  0: go to the last instruction 

  >0: go to previous x steps 

  <0: go to next steps 

Y: Goto Mode 

  0: jump by instruction number 

  1: jump by label 

Text: instruction label to jump to if Y 

equals 1 

No 

9 Script Control Set Label 

Set a label for branch instructions (Go to, 

Page Id) to jump. 

 

Text: label name 

No 

10 Script Control Sleep 
Suspends the script for the specified 

number of milliseconds. 
No 

11 Script Control Loop 

Execute specified steps cyclically 

 

X: Loop in execution. ≠0:Previous number 

of instructions; =0:Go to the last 

instruction 

>0: go to previous steps; 

=0: go to the last instruction 

<0: go to next steps 

Y: Loop is ended. ≠0:Next number of 

instructions; =0:Go to the last instruction 

>0: go to next steps 

No 



=0: go to the last instruction 

<0: go to previous steps; 

 

W: This value denotes the iteration times 

of the loop 

Q: should be 0  

 

Note: Do not use 2 Loops for nested-loop. 

Use Loop & Loop2 instead. 

12 Script Control Loop2 

Execute specified steps cyclically. 

Parameters are the same as Loop 

 

Note: Do not use 2 Loop2s for 

nested-loop. Use Loop & Loop2 instead. 

No 

13 
Page 

Identification 
Page Id 

Identify the page id of current frame and 

jump to certain instruction if page id 

equals given id number. 

 

X: number of instructions to jump (see Go 

to) 

Y: jump mode.  

  0: jump by instruction number 

  1: jump by label 

W: target page id 

Text: instruction label to jump to if Y 

equals 1 

 

E.g. For setting Y=1, W = 3, Text = “page3”, 

script will jump to the instruction labeled 

“page3” if current page id is identified as 

3. See more examples in 5.2. 

Yes 

14 
Page 

Identification 
Screen Shift Cab 

Detect horizontal offset from grabbed 

image and correct the offset in ± 3 pixels if 

detection successes. 

 

X: number of instruction to jump if 

calibration failed (see Go to) 

Y: jump mode 

Yes 



  0: jump by instruction number 

  1: jump by label 

Q: Threshold 1-100 to page matching. 100 

means 100% matching. 

 0: default value, 95 

 

Note. Calibration is done with page 

identification patterns, in others words, if 

there is no page identification pattern, this 

instruction will result in fail.  

15 Data Processing 
MSG SAVE TABLE 

TO LOG 

Save selected table items to file. The 

indices of selected is specified by Text.  

X: 0 for save all items and 1 for save 

selected items. 

   

Y: log file path 

  0: default log file 

(<MyDocmuents>\RCM_TABLE_LOG) 

W: log format 

  1: JSON format (<Program 

Files>\ADLINK\DEX-100\main\LogJson\Ma

chineStatusLog) 

  2: XML format (<Program 

Files>\ADLINK\DEX-100\main\LogXML\Ma

chineStatusLog) 

H: send to DDS/Restful module 

  1: true 

  2: false 

Q: Restful Upload style 

  0: once 

  1: one by one 

Text: log file path or selected indices.  

 

Note. Index format: a~b [; c~d]*.  

For example: 

If index equals to 1~3; 5~7; 9~10, then 

Item #1, #2, #3, #5, #6, #7, #9, #10 will be 

selected to process. 

No 



16 Data Processing Replace string 

Replace oldValue with newValue for the 

selected Table item.  

 

X: item index 

Text: oldValue newValue 

 

Note: The oldValue and newValue have to 

split by Tab. If newValue is not given, 

oldValue will be replaced by empty string. 

No 

17 Data Processing 
Replace string by 

regex 

Replace pattern with newValue by regex 

for the selected Table item. 

 

X: item index 

Y: regex option 

 0: None  

 1: ignore case when matching 

 2: multiline mode, where ^  and $  match 

the beginning and end of each line   

16: single-line mode, where the period (.) 

matches every character (instead of every 

character except \n ) 

32 : Exclude unescaped white space from the 

pattern, and enable comments after a 

number sign ( # ). 

  

Text: pattern newValue 

Note: The pattern and newValue have to 

split by Tab. If newValue is not given, 

pattern will be replaced by empty string. 

See more details for regex option in 

https://docs.microsoft.com/en-us/dotnet/

api/system.text.regularexpressions.regexo

ptions?view=netframework-4.7.2. 

No 

18 Data Processing set Table Value 
Set value to selected table item. Use Q to 

select comparison or arithmetic function. 
No 



 

Set Value Function 

Q = 0: Set value to selected table item 

X: item index. 

Text: value. 

 

Comparison Function  

Q 

1: compare item and target as integer 

numbers 

2: compare item and target as strings 

5: compare item and target as float 

numbers 

X: item index 

Y: jump offset if item value equals to 

target value 

W: jump offset if item value is larger than 

target value 

H: jump offset if item value is less than 

target value 

Text: target value. 

 

Arithmetic Function 

Q: 

3: subtract target value from item as 

integer numbers 

 4: add target value to item as integer 

numbers 

X: item index 

Text: target value. 

19 Data Processing Table Compare 

This instruction evaluates the expression 

and branch to other instruction according 

to result.  

X: Compare Succeed.  

+x: go to previous steps; 

=0 go to the last instruction 

-x: go to next steps 

Y: Compare failed and expression error.  

No 



+y: go to previous steps; 

=0 go to the last instruction 

-y: go to next steps 

 

Text: Comparison expression. Maximum 

Length: 128 

 

Available Expression Functions (Function 

names and strings are case sensitive): 

Table(): retrieve table item as string.  

ReadFile(): read file from path 

Num(): convert string to float number. 

E.g. Table(3) == "123" 

E.g. Table(0)==ReadFile(“C:\\input.txt”) 

E.g 1.5<=Num(Table(0)) && 

Num(Table(0))<=4.2 

 

 

Available Expression Operators: 

()                               

+ - * / %  

< <= == != >= > ! 

&& || 

 

Note 1. 

String operations are available (+, < <= 

== != >= >). 

"appl" + "e" == "apple" 

"apple" > "app" is true 

See, .Net String.CompareTo for more 

details. 

 

Note 2 

Use ‘\’ as an escape character. 

\a Alert 

\b Backspace 

\f Form feed 

\n New line 

https://msdn.microsoft.com/zh-tw/library/35f0x18w(v=vs.110).aspx


\r Carriage return 

\t Horizontal tab 

\v Vertical tab 

\' Single quotation mark 

\" Double quotation mark 

\\ Backslash 

 

Note 3. 

Integer division is supported. 

3/2 equals to 1 

3.0/2 equals to 1.5 

20 OCR Function Check Text 
Check OCR result and compare with input 

text 
Yes 

21 OCR Function Get bmp Get screen image Yes 

22 OCR Function Get bmp rect Get bmp selection.  Yes 

23 OCR Function Get bmp rect array 

Perform OCR to selected ROIs. This 

instruction is normally generated by 

“Combine Script”.  

 

Q: Snapshot current frame to jpg or 

png(default). The folder will be 

<MyDocuments>\RVM_OCR_IMG and the 

filename is current time, 

YYYYMMDDHHmmss.png (or jpg) 

  0: disable 

  1: enable 

(refer to Script Setting image format 

setting) 

H: Write log to log-file if H equals1. 

Yes 

24 OCR Function img refresh 

Refresh page by grapping new frame 

 

X: frames to skip  

  0: disable 

  1: enable  

W: value of frame number to skip 

Yes 

25 OCR Function Send OCR 

Sending OCR result to buffer 

If OCR Mode = 0, 

Unique cfg: 

Yes 



Back group color range:  

Picture noise, picture to gray scale, 

adjacent point chromatic aberration is less 

than this value is white, greater than this 

value is black. 

Later color threshold:  

Picture chromatic aberration threshold 

percentage value, after the picture turns 

the gray scale, makes the color judgment 

to the black position; the larger the value 

retains the more black spots. 

Minimum blank grid:  

The smallest blank pixel length between 

words and characters, and if the white 

space pixel length is greater than this 

value, it is treated as a space between 

words and words. 

Blur Noise、Blur Threshold:  

When the background color is removed in 

the above range, the image still is not 

matched, these two parameters are 

adjusted again for the blur noise and 

threshold  

Cut Word: 

Normal(0): It reflect the truly image, so it 

make every joined characters to a 

character 

Precise(1): Make every character a white 

space even if any two joined characters 

 

Note: It can’t use with “Get Color” and 

“Check Color” in the same image layer 

26 Script Control Get Color 

X: Color coordinates x 

Y: Color coordinates y 

W: Color width 

H: Color height 

It supports single color or multiple colors 

for this ROI 

Yes 



1. multiple colors 

Text: R;G;B\R;G;B\R;G;B 

Three color example: 

255;255;255\0;0;0\212;30;56 

2. single color 

Text: R;G;B 

Single color example 

255;255;255 

Note: It can’t use with “Send OCR” in the 

same image layer 

27 Script Control Check Color 

X: Check color succeed 

+x: go to previous steps; 

=0 go to the last instruction 

-x: go to next steps 

Y: Check color failed 

-y: go to previous steps; 

=0 go to the last instruction 

+y: go to next steps 

W: Get color command number 

The first command need to set 0, the 

second is 1, so the nth command is n+1 

H: Check color command number of the 

Get Color 

The first color need to set 0, the second 

color is 1, so the nth color is n+1 

Q: Retry times 

If 0 not retry, else set n is retry times 

Note: It can’t use with “Send OCR” in the 

same image layer 

Yes 

28 Mouse Action Left Click 

Perform mouse left click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

29 Mouse Action Left Click Down 

Send mouse left click down event 

 

X: cursor coordinates x 

Yes 



Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

30 Mouse Action Left Click UP 

Send mouse left click up event 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

31 Mouse Action Left D Click 

Perform mouse left double click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

32 Mouse Action Right Click 

Perform mouse right click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

33 Mouse Action Right Click Down 

Send mouse right click down event 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

34 Mouse Action Right Click UP 

Send mouse right click up event 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

35 Mouse Action Right D Click 

Perform mouse right double click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Yes 



Enable is 1, Default is disable 

36 Mouse Action Medi Click 

Perform mouse center click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

37 Mouse Action Medi D Click 

Perform mouse center double click action 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

38 Mouse Action Move 

Move mouse cursor to specific coordinates 

 

X: cursor coordinates x 

Y: cursor coordinates y 

W:cursor detection enable 

Enable is 1, Default is disable 

Yes 

39 Mouse Action Mouse Reset Reset cursor position to top-left of screen  

40 Keyboard Action Alt Down +Tab Press down ALT and press and release Tab  

41 Keyboard Action Alt Up Release ALT  

42 Keyboard Action Key In 

Perform text key-in action. 

 

X: specify data source 

 1: from text 

 2: none 

 3: from table value 

 4: from file 

Y: table item index if key-in from table 

Text: text or file source to key-in. 

Yes 

43 Keyboard Action Send BackSpace Press and Release backspace Yes 

44 Keyboard Action Send Clear 
Send CTRL+A and BackSpace multiple 

times to clear text content. 
Yes 

45 Keyboard Action Send ESC Press and Release ESC key Yes 

46 Keyboard Action Send Enter Press and Release Enter key Yes 

47 Keyboard Action Send Function Key 
Press and Release F1-F12 

 
Yes 



X: specify function key 

0:default (F1) 

1:F1, 2:F2, 3:F3… 12:F12 

48 Keyboard Action Send Keys 

Send keys 

Text: key, choose the key under the “Add 

Key” button and click the “Add Key”, it will 

set the Send Keys value 

Yes 

49 Keyboard Action Send Up Press and Release UP key Yes 

50 Keyboard Action Send Down Press and Release Down key  Yes 

51 Keyboard Action Send Left Press and Release LEFT_ARROW key Yes 

52 Keyboard Action Send Right Press and Release RIGHT_ARROW key. Yes 

53 Keyboard Action Send Home Press and Release Home key Yes 

54 Keyboard Action Send Tab Press and Release TAB key Yes 

55 Keyboard Action Send Ctrl + C Send CTRL + C event Yes 

56 Keyboard Action Send Ctrl + V Send CTRL + V event Yes 

57 Keyboard Action Send Ctrl + A Send CTRL + A event Yes 

58 Keyboard Action Send Ctrl + Alt + C Send CRTL + ALT + C key event Yes 

59 Keyboard Action 
Send Alt + Space + 

X 

Send Alt + Space + X. To maximize 

Window. 
Yes 

60 Keyboard Action Send Alt + O Send ALT + O key event Yes 

61 Keyboard Action Send Alt + Space 
Send ALT + Space. To open the window 

menu. 
Yes 

 

6. DEX-Pro image quality and mouse 

adjustment with diagnostic tool 
NOTE: Changing these setting may make DEX-100 system work unexpected. 

6.1. Keyboard/Mouse Lost Precision 
When you discover mouse lost the coordination as script describe. Or keyboard input to target machine lost some 

character. This may the target machine’s response time more then we expect. DEX-100 could defer the data transmit 

time to target machine by modifying Windows™ registry. 

 



 

 

Registry Location: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\avsdex100\Parameters\PS2KeyBoardCommandDelay 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\avsdex100\Parameters\PS2MouseCommandDelay 

Default Value: 2 

Data Type: DWORD 

 

If DEX-100 encounters keyboard or mouse data lost, please add the above registries as following. 

 

And change the delay value to a larger one (2-10) and check if the precision rate is improved. 

After changing value, the DEX-100 device driver must be restarted to load this new value. 

 

Validation Approach: 

 

Use DEX-Pro script to check mouse or keyboard is lost data.  

6.2. VGA Sampling Phase Delay Adjustment 
When discover frame image blur from VGA input. DEX-100 provide VGA sampling phase delay parameter. 

 



 
 

Method 1: Use Diag.exe to change setting

 

1) Go to the folder: C:\Program Files\ADLINK\DEX-100\utility. Open the Diag.exe and press “Start” button. 

2) Save image to check the character or use Windows™ provided Magnify.exe (C:\Windows\SysWOW64\) to 



view the character shape. 

3) Adjust “Sampling Phase” value. 

 

 

Sampling Phase value 10, “ADLINK” is aliased.  

 

 

Sampling Phase value 18, “ADLINK” is cleared. 



 

 

 

NOTE: If use Diag.exe changes the value, it would write the value to registry to keep change persistence. Watch next 

method 2 for registry description. When you do not keep this value, delete the registry key manually and restart 

DEX-100 device driver. 

 

Method 2: Modify Windows™ registry 

 

Registry Location: 

HKLM\SYSTEM\CurrentControlSet\services\avsdex100\Parameters\SamplePhase 

Range: 0x40 ~ 0x5F 

Data Type: DWORD 

 

After changing value, the DEX-100 device driver must be restarted to load this new value. 

 

 

Video Quality Analysis 

1. Add a “Video Quality Analysis” button in Diag.exe utility. (This test only valid in VGA source) 

 

2. When user clicks “Video Quality Analysis” button, The Diag utility pops up a dialog of Video Quality Analysis test.  

This test will help user to determine the best Sampling Phase and the Dynamic Noise. 

It finds the best Sampling Phase by setting the Sampling Phase form 0 to 31 and gets the Sampling Phase with 

the best sharpness score and change the Sampling Phase if it founds it. 

It finds the Dynamic Noise by calculating the difference of two continue images. 



 

There are five sections in the dialog. 

i. Sharpness score for each Sampling Phase 

To show the sharpness score in each Sampling Phase (0-31) in this time.  

ii. History of the best Sampling Phase 

To show the history of the best Sampling Phase value with time information. 

iii. Count of best Sampling Phase 

To show the count of the best Sampling Phase and list in decrease order. 

iv. History of Dynamic Noise 

To show the history of Dynamic Noise with time information. 

v. Statistics 

This section shows some statistics information among the test which includes if the video stable (Note 

1), the average of Dynamic noise(Note 2) and the other noise information (max, min, average) 

If the check box, Do not set Sampling Phase, is clicked, the Sampling Phase will not be changed after 

the test. (For QC test) 

   The testing can be stopped by clicking stop button. 

Note 1. 

The Video Quality test will determine if the video is stable or not by following rule. 

1. Get the total test count (T). 

2. The count of the most Sampling Phase is C1, the Sampling Phase value is S1. 

The count of the second Sampling Phase is C2, the Sampling Phase value is S2. 

Ex if Count of SamplingPhase[26] = 100, than C1 = 100,  S1 = 26 

    Count of SamplingPhase[27] = 80, than C2 = 80,  S2 = 27 

    Count of SamplingPhase[25] = 50,than C3 = 50,  S3 = 25 

3. Add the count of Sampling Phase for the most (C1) to the less (Cn) until the sum of them is over 70% 

of total test count. 

C1 + C2 + … + Cn >= T * 0.7 

4. If n=1, than the video is stable. The best Sampling Phase is S1. 



5. If n > 1, than calculate the distance between C1 and C2(D12), C1 and C3(D13),…, C1 and Cn(D1n) (The 

Sampling Phase is arrange as a circle, the distance of the ends is 1) 

6. If all the Dmn < 2, than the image is stable and the best Sampling Phase is S1 or the video may not 

stable. 

 

Note 2. 

 

 

 

 

 

 

The following are the algorithm of Dynamic Noise calculating 

1. Capture two continue pictures P and P'. In theory these tow picture are all the same beside the 

noise. 

2. Transform all pixels in P1 and P2 to gray level and get the average gray level of these two 

pictures (A). 

3. Get the noise of each pixel by calculate the difference of this pixel in these two pictures. Noise 

at (x, y) = |p'(x,y) - p(x,y)| 

4. Assume the image resolution is 1920 x 1080, than we get 2,073,600 ( 2 millium ) noise values. 

5. Calculate the Average(a) and Standard Deviation(σ) for these 2 millium noise values 

6. Assume the noise is Normal Distribution, we can expect the 95% noise of each pixel is 

between  a-2σ and a+2σ. 

7. The dynamic noise of this moment is 2σ+a/A. 

 

  



Setup steps 

1. Set Test interval and Total Test Time. (Ex. Test interval 1 minute, and run 30 mins) 

 

2. Click Start button to start the analysis video and select a folder to save log file first. It shows the estimated disk 

space. It will use the same folder of Diag.exe If user selects “Cancel”. 

 

3. When the test is running, it shows some information in statistics which includes the current image status, max 

count of Sampling Phase, average value of the Min, Max, Mean noise, the average Dynamic Noise, next test 

start time, the test finish time and test count. (in percentage) 

 

4. When the test finished, it will show a summary in message and there are a log file, VQLog.csv and test images 

in the folder where user choose on the beginning of the test. 

It also records the Dynamic noise value in the C:\ProgramData\ADLINK\DEX100\VideoQuality\ 

VideoQualityStatistics.xml for the Page identify ROI threshold auto tuning. 

  



 

6.3. Horizontal Delay Adjustment 
When target machine shows a black vertical line in DEX-Pro display frame, change the HDaly value could move the 

vertical line position. 

 

Method 1: Use Diag.exe to change setting 

1) Open the Diag.exe and press “Start” button. 

2) Discover the left vertical line has black line.  

3) Checked “Force Horizontal Delay” to keep the value in system registry. 

4) Changing the “Horizontal Delay” value to check the lines disappear. 



  



  

 

 

NOTE: If “Force Horizontal Delay” is unchecked, next time DEX-100 would not load the modified Horizontal Delay value 

after reboot. 

NOTE: Due to the analog signal decode limitation; there may be a thin black line (about 2 pixel width) at the left side of 

the captured image in some resolutions (ex.1280x768). 



 

 

Method 2: Modify Windows™ registry 

 

Register Location: 

HKLM\SYSTEM\CurrentControlSet\services\avsdex100\Parameters\HDelay 

Range: -3 ~ 3 (0x80 ~ 0x87) 

Data Type: DWORD 

 

 

 

 

 

 

 

6.4. Video Frame Position Adjustment  
Utility 

1) Open Diag.exe and start target machine screen capturing.  

 



2) Press Frame Adjust button 

 
This dialog shows video frame horizontal and vertical display timing value (Start of Active Video/End of Active 

Video/End of Ver. Back). Offset values are adjusted via the arrow buttons. When move video frame to right, the Active 

Video should be decreased, so the Horizontal Offset value would be decreasing. When move video frame to up, the Ver. 

Back value should be increased, so the Vertical Offset value would be increasing. 

After adjustment, these offset values were store in system registry. 

 

Registry Location: 

HKLM\SYSTEM\CurrentControlSet\services\avsdex100\Parameters\FrameAdjust 

Default Value: 0 

Data Type: DWORD 

Note1: This value is not recommend to change manually. 

Note2: This adjustment is only for VGA signal. 

 

6.5. Mouse Cursor Auto Calibration 

Utility 

Use this function to check target PC mouse move data is sent correctly. If mouse cursor does not detect in pre-defined 

position, program would defer the mouse move data send speed. And restart the check progress in 5 times. 

USB Input Delay range: 6~ 22 micro-second 

The detect path as this illustration. Program move mouse to 4 desktop corner and check the cursor is on the position. 

Run in Test Round times. 



 

Operation Steps: 

1) Open Diag.exe and start capturing to enable Cursor Calibration button. 

 



 

2) Click Cursor Calibration button. 



 

3) Input Test Round # number (recommend value around 100~500) and Start testing. 

a) Program would display 6 cursor golden samples (size 32x32).  

Note: Make sure these images contain cursor. If not re-start the progress or increase the "USB Input 

Delay" 

b) If a round test success, log console print Pass 

c) If a round one cursor fail, log console print Fail 

 Program auto increase USB Input Delay value and run test again. 

6.6. Cursor Detection Operation 

6.6.1. The Brief of Cursor Detection  

1. Please open Diag.exe program from the DEX-100 SDK install folder. 



 

2. The DEX100 Diagnostic Program Utility shows as below.  

 

3. The Cursor Detection related components are descripted as following:  

UI component Descript 

 /  

To start or stop capture. when capturing, the DEX-100 moves 

the host’s mouse to the same position as DEX-100’s mouse. 

 

The Sample Phase is about the video quality, please reference 

“6.2 VGA Sampling Phase Delay Adjustment” for the detail 

descript. 

 

The status of the Cursor Detection function: 

 Mouse Pos: The DEX-100’s mouse position.  

 Status: The status of Cursor Detection, it may be 

following values. 

 0 : The DEX-100 finds one mouse cursor. 

 3 : The DEX-100 finds the same cursor at different 

position. 

 4 : The DEX-100 finds more than one cursors at the 

same time. 

 5 : The Cursor Detection parameters are loaded. 

 6 : The Cursor Detection parameters are failed to 

loaded. 

 255 :  The DEX-100 doesn’t find any mouse cursor. 

 Idx: The mouse index which is set in Cursor Detection 



Process 

 HostMousePos: The Host’s mouse position. 

 Score: The reference value of the max cursor score in the 

current image. (show in the order of cursor 1, 2, 3, 4) The 

value is used to help user to adjust the score for each 

cursor setting, the score set in setting should be lower 

than the max score then the cursor can be detected. 

In general case, the max score should be about 310 or 

above, if the max score is too low, please check the 

cursor mask or the image quality. 

 

Open Cursor Detection Process dialog 

The Cursor Detection Process Dialog is as following 

 

UI component Descript 

 

Shows all the cursor settings, DEX-100 can store 4 cursor 

types. 



 

 ROI Size : the host mouse cursor’s position, size and 

offset. 

 Offset : The offset of cursor up-left point .DEX-100 

detects cursor and reports the position of cursor’s 

up-left point. 

Adjust the Offest X and Offset Y  if the cursor was not 

at the left and top side of Cursor Image. 

  

 

The cursor image and background image. 

DEX-100 uses difference of two images, picture with cursor 

and without cursor, to recognize the cursor shape. 

 

 Get Cursor Icon : DEX-100 depends on the selected 

method to cursor icon. 

 Correction : to adjust the cursor shape. 

 Load : to load the cursor files by choose Coursor_.bmp 

and CursorMask_.bmp to load the cursor sharp setting. 

 

 Index : The index of cursor setting. 

 Score : The matching percentage of the score. The 

range of score is 0 – 320 and we recommend score 

value as following. (Please reference Make Cursor 

Patterns Process 8.c and I-Beam Cursor Shape 

Capturing 3.) 

 Arrow : 304 - 308 

 I-Beam : 314 – 316 

 

 

 Safe region : an area where the mouse can always be 

detected. 

 When Cursor Detection was enabled but the DEX-100 

can’t find mouse cursor, the DEX-100 moves the mouse 

to the safe region and try to find the cursor then 

continue. 

 

 Cursor Detection Enable : Indicates the Cursor 

Detection function is enabled or not. 

 

 Load : to load the cursor detection setting  

 Set :  to set the setting to DEX-100. 

 



6.6.2. Make Cursor Patterns Process 

1. Press Cursor Detect Process. 

 

2. Press Load to load previous or default configuration. 

 

3. Start Diag utility screen capturing.  

4. Move the mouse cursor on screen capturing panel and left 

click mouse to fix ROI left-top position. 

Note: Recommend move the mouse cursor to a place with 

a simple color background (ex. all white or blue) for the 

better mouse cursor image 

 

5. Do not move mouse and right click to get image with cursor. (image 1)    

 



6. Move the mouse to another position and press Get 

Background Image on the Cursor Detection Dialog to 

get the background image. (image 2)  

7. The ROI Size indicates the mouse cursor position (X,Y) and the cursor size (W, H). 

8. Adjust the Offest X and Offset Y than repeat step 5 – 7 if  the cursor is not at the left and top side of Cursor 

Image. 

9. Press Get Cursor Icon procedure to get the first cursor sharp calculating by image 1 and image 2. 

 

Note: There are three methods to get the cursor sharp. For a simple color background (all white or blue etc.), the 

method one gets a better result, otherwise for a multi colors background please use method 2 or 3 to get the 

cursor shape. 

a) The shape may not be perfect. Please adjust the mask region by left or right click on the Icon Mask and 

check the result on the Cursor Icon Preview. 



 

Note: The cursor mask is very import for the cursor detection. There are some tips to get a good cursor 

shape. (please reference to right picture marked with red) 

I. Don’t mask the cursor edge line, (ex. dark line in light cursor).  

II. Mask all background and cursor shadow points. 

III. Mask the left edge of the cursor. 

b) Bellow mask is correct cursor detection mask. 

   

Incorrect cursor detection mask  

(No cursor edge) 

Correct cursor detection mask Incorrect cursor detection mask 

(Need to mask the cursor shadow) 

c) Set cursor shape score. And press Add Icon to add/modify cursor parameters. We recommend Arrow 

cursor score recommend use 304-308 to get better detect rate. 

Note:  

The score is a matching percentage of the cursor. The maximum value of the score is 320. 



 

There is not a perfect score value for all machines. Basically, the higher score means the more accurate 

matching but it also might cause the cursor detection fails to find the cursor. On the other hand, if the score 

was too low, the cursor detection may find more than one mouse cursor at the same time. 

The below table indicates the relation between score and the result of Cursor Detection. 

Score Result Note 

320 

319 

…… 

316 

315 

The DEX-100 doesn’t find the mouse cursor. 

The DEX-100 doesn’t find the mouse cursor.  

…… 

The DEX-100 doesn’t find the mouse cursor.  

The DEX-100 doesn’t find the mouse cursor. 

The score is too high 

314 

313 

…… 

302 

The DEX-100 finds one the mouse cursor. 

The DEX-100 finds one the mouse cursor. 

……   

The DEX-100 finds one the mouse cursor. 

The score is medium 

301 

300 

The DEX-100 finds the same cursor at different positions. 

The DEX-100 finds the same cursor at different positions. 

The score is too low 

 



10. Enable the Cursor Detection, set Safe Region and Edge Threshold.

 

  Note:  

I. Safe region is used for the cursor detection process. Please find an area where the mouse can always be 

detected. 

II. Edge Threshold is used for the edge recognition. Recommend use 60 to get better detection rate. 

III. The Move Delay and Auto Set are not used now. 

11. Press Set to set configuration to DEX-100 machine and close the Cursor Detection Process Dialog. 

 

 



12. Please make sure the mouse compensation function is enable by the Config.xml. 

1) Open the Config.xml 

 

2) Check the Compensate is 1 and save file. 

 

6.6.3. I-Beam Cursor Shape Capturing 

1. I-Beam cursor coordination from system report is at middle of cursor image. To capturing the full cursor image, 

You can adjust the ROI Offset X/Y. 

2. Like upper Dialog figure, set the Offset to (-2, -7) to capture full I-Beam image. 

 

3. Get the shape like bellow figure and adjust the cursor shape. 



 

Note: For the I beam shape adjusting 

 (Please reference to right picture marked with red) 

I. Extend on pixel column on the middle pillar, top and bottom. 

II. Mask the left edge.  

 

Note: I-Beam cursor score value recommend among 314 - 316 to get better detect rate. 

6.6.4. Score Recommendation 

Cursor Type Feature Mask Method Recommend Score 

Arrow Thick 1. Include cursor edge. 

2. The most Left edge should be masked. 

304-308 

I-Beam Thin 1. Middle pillar pixel right extend on pixel. 

2. The most Left edge should be masked. 

314-316 



6.6.5. Check the result of Cursor Detection 

1. Please go the DEX100 Diagnostic Program Utility and restart capture to make the Cursor Detection setting work. 

2. Enable the Show Detected Cursor on DEX100 Diagnostic Program Utility and move the mouse on the captured 

video to check the status of Cursor Detection. The status should be 0 in most positions. 

 

Status situation Possible cause and Action 

0 The DEX-100 finds one the mouse cursor. None 

3 The DEX-100 finds the same cursor at different 
position. 

The score maybe too low, please adjust the score to 
higher or adjust the mask. 

4 The DEX-100 finds more than one cursors at the 
same time. 

At least one of the score maybe too low, please check 
the score for each cursor and adjust to higher or adjust 
the mask. 

5 The Cursor Detection parameters are loaded. None 

6 The DEx-100 fails to load Cursor Detection 
parameters. 

The system may be busy, please restart DEX100 
Diagnostic Program Utility 

255 The DEX-100 doesn’t find mouse cursor. The score maybe too high, please adjust the score to 
lower or adjust the mask. 

3. If the status is often 3, 4 or 255, it means the Cursor Detection does not work well, please adjust the score or 

check the mask as following steps. 

1) Press Cursor Detect Process. 



 

2) Press Load to load previous or default configuration. 

 

 

3) Press Load to load to the cursor files by choose Coursor_.bmp and CursorMask_.bmp in sequence to load 

the cursor sharp setting configuration. 



 

 

4) Press correct to adjust the mask. 

  

5) Depends on the Cursor Detection status and the max cursor score to adjust the score to lower or higher 

one. 

6) Select the cursor index and press Add Icon to modify Cursor parameter. 

7) Press Set to set configuration to DEX-100. Close the Cursor Detection Process Dialog and check the result 

of Cursor Detection. 



Note: If the mask and score were all fine, it may because the video quality is too bad. Please adjust Sampling 

Phase to optimize the video quality.  

i. Please reference 7.2 VGA Sampling Phase Delay Adjustment for the detail setting of the Sampling 

Phase. 

ii. If the Video quality change, the OCR library may need to be training again to adapt the word in the 

new video displayed. 

6.6.6. The History of Cursor Status 

Add the history of cursor status information. In ideal case it should larger than 310. 

 

 

Score of cursor 

detection status 

Note Action 

Score < 300 The DEX-100 can’t find the cursor in the 

image or it finds the cursor but the 

similarity is very low. 

User may need to adjust the cursor 

mask or adjust the sampling phase 

to improve the video quality. 

300 <= Score < 310 The DEX-100 finds the cursor in the 

image but the similarity is not good 

enough. The cursor detection still works 

We suggest user review the cursor 

mask or adjust the sampling phase 

to improve the video quality. 



if user set a low score in Cursor Shape 

Define. 

 

310 <= Score The DEX-100 finds the cursor in the 

image and the similarity is good. 

 

 

Note. 

DEX-100 compares these two scores and finds the cursor if the score of cursor detection status 

is larger or equal to the score in Cursor Shape Define. 

 

        

Score of cursor detection status v.s. Score in Cursor Shape Define. 

Condition Note 

Score in cursor detection status < score in Cursor Shape Define. DEX-100 can’t find the cursor. 

Score in cursor detection status >= score in Cursor Shape Define. DEX-100 finds the cursor 

 

6.6.7. Pre-Scan the status of Cursor Detection 

If you already set up the cursor detection, you can pre-scan every pixel on the Diag.exe. We will show how to use step 

by step as follows. 

1. You have to set the X, Y, W and H to decide what scope you want to confirm the status 

2. If you check Show All status, it will show all the status included the status 0 (succes). Or you will only get the 

status not equal to 0, it may be (1,2,3,4,7) 

 

ID Status Description 

0 SUCCESS No error occurs 

1 ERROR_CANNOT_DETECT Mouse could move to safe region and 

detected, but cannot detect in move 

function position 

2 ERROR_CANNOT_CONTROL Cannot control mouse to safe region 

3 WARNNING_MULTI_POS Single cursor match but has multi position 

4 WARNNING_MULTI_CURSOR Multiple cursor patterns detected 

5 CURSOR_DETECT_LOAD Driver had load the cursor detection 



6 CURSOR_DETECT_FAIL Driver does not load cursor detection 

7 CURSOR_LOSE_PRECISION Cursor can control but it position is not at 

defined position 

8 CURSOR_POSITION_LOST_IN_EDIT_MODE Cursor cannot find in EDIT control mode. 

 

3. Click the “Cursor Detection Preview” to start 

 

4. It will show the scanning result on “Status” every pixel and generate the result on the C:\Program 

Files\ADLINK\DEX-100\utility\scan_result.txt 

 

6.6.8. Cursor Detection in DEX-Pro 

Before you start the cursor detection function, you have to check as follows. 

1. Set up the cursor pattern (Section 6.6.1~6.6.5) 

2. Set the cursor detection enable or disable and cursor detection re-try times (Chapter 3. Toos Menu) 

3. Any mouse command to enable the cursor detection (Chapter 5.Script Command – Mouse commands) 

In running mode, there are 3 status to force to stop the script, and they are status 1, 2, 7. You can refer the table in 

previous section (6.6.6). And any cursor detection and script step stopping log will be record on the C:\Program 

Files\ADLINK\DEX-100\main\Dex-100\Logs. 

6.7. Configuring Unsupported Resolution  
When the DEX-pro can’t detect the inputs video resolution and fails to capture image form machine. User may need to 

reports the video timing to ADLINK. This chapter indicates how to get the video timing of unsupported resolution. 



1. Open the ADLINK Sensor Format Detection Tool. (ADLINK_SFDT.exe) 

 

2. Select the Video Channel (VGA or DVI) and press Sense 

 

3. Provide the resolution, fps and all the video timing values that are read from the tool and send back them to 

ADLINK. 

4. ADLINK returns a new text file for the new resolution. 

The VGA resolution list is stored in dex-100_rgb.txt. The DVI resolution list is stored in dex-100_hdmi.txt. 

5. Paste and replace the text file in C:\Windows and restart the driver. 

  



6.8. OCR Error Handling on Char/ Digit 
Owing to the new OCR replacement mechanism, we provide a check OCR result on Char/Digit 

for other OCRs. It is similar with ADLINK Table on original version, but it will remove the 

replacement on table mapping. Its main purpose is providing the log mechanism to help user get 

the error word include the character index, original setting format, returned character and ROI ID 

information. Besides the ROI images will be saved, users can map the log information and get the 

corresponding ROI images to feed the OCR training or analysis. 

GUI:  

 It is the same as Adlink Table checkbox to enable this function or not. If the tesseract OCR is 

enable in machineini.ini, it will switch to tesseract OCR and the Adlink Table will be performed for 

above function. 

Log Format & Path: 

 ROI Image 

 ROI saving picture path:  C:\New_OCR_ROI_IMG\ 

e.g: C:_\New_OCR_ROI_IMG\ 

 ROI image file name: ImageLayer + ROIImage + ROIID + ‘_’ + year +’ –‘ + month + ‘- ‘ + day 

+ ‘ _’  + hour + ‘. ‘ + min + ‘.’ + sec + .bmp 

(ImageLayer-ROIImageID_yyyy-MM-dd_HH.mm.ss.bmp) (To avoid the different image 

layer has the same ROI ID) 

e.g: getimg_001-ROIImage6_2018-08-30_12.00.00.bmp  

 Log 

 Tesseract log path: C:\Program Files\ADLINK\DEX-100\main\Dex-100\OCR\ 

 Tesseract log file name: logfile.txt 

 Tesseract log format: OCR error- ROI ID:(ROIID) ,Check char:(check returned OCR char) , 

index:(char index in word) , ori: (original user setting format) 

e.g: OCR error- ROI ID:8, Check char:e, index:1, ori: N, User set the second char format is 

'N', but returned value is 'e' (it is the l format - lowercase char) 

6.9. Tesseract 3.05 Functionality 
Owing to the Tesseract 3.05 new OCR mechanism, we provide two important features for 

enhancement on the DEX-Pro. One is the confidence level to provide user a threshold to decide the 

OCR result keep or not. It not only providing the average of all characters but also checking the 

minimum of the choosing characters. Other is adding the resizing image algorithm on the 

interpolation and super resolution when the image is too small to impact the OCR result. Besides 

the confidence level and pre-processing (resizing image), it enhances on whitelist which user can 

input characters to let the OCR result only in the specific configuration set. 

GUI: 



 

 When you set the OCR Mode = 1, the OCR will change to Tesseract 3.05 and the “Model and 

Configuration Management” item will be visible. 

 
This management includes two parts: (1) Import/Export the Tesseract related files; (2) Delete 

existing Traineddata and Config files. 

(1) Import/Export the Tesseract related files 

Use Export or Import button to save or include your own Tesseract related files. There are 

three options are provided. You can import/export the “traineddata” or “config” only. Or you 

can both import/export the “traineddata” and “config”. Notice that if the “traineddata” and 

“config” import or export, the metadata file will also be import/export. 

(2) Delete existing Traineddata and Config files. 

There you can delete the “Traineddata” or “Config” files separately. Notice that your deletion will 

(1) Import/Export the 

Tesseract related files. 

(2) Delete existing 

Traineddata and Config 

files. 



affect all set metadata files of the current Tesseract ROI settings. 

 

 Tesseract OCR settings: 

After choosing the target ROI (see the red Rectangle below marked as 0), you can start to set 

the Tesseract related parameters after pressing the “Add OCR” button frame selected as green color. 

 

 

 

 

 

After you pressed the “Add OCR”, ROI #(here represents your ROI number) setting form 

showed up, See the picture below. You can select an existing setting or you can create your own 

setting by pressing the “new” button. 

 

1. Select an existing setting: Select the existing ROI setting in the “Existing ROI Settings” panel. 

After you chosen an existing setting, you can preview it by “Preview” button. There will show 

each properties of this setting in the “Content Viewer” form. 



 

 

2. Create a new setting: If there’s does not exist a proper setting, you can create a new setting to 

meet your requirements. Press the “new” button and the “OCR ROI Settings” form will show. 

You can select an 

existing setting. 

Preview the 

selected 

setting. 

You can create a 

new setting in 

need. 
You can delete 

an existing 

selected setting 

above. 



 

 

Traineddata and Configuration: 

i. Choose the Tesseract traineddata (multiple selection). The Select/Deselect All button can 

let you quickly edit. 

ii. Choose the configuration (single selection). Press the Advanced Setting button for 

Tesseract advanced settings if required as follow. For the more parameters information in 

detail, you have to refer the tesseract from google. 



 

Confidence: 

There are two choices on the “Confidence Level Decision”. 

 Average: It will let the user-defined confidence level value compare with the truly tesseract 

confidence level average value. E.g. Test, T:80, e:60, s:70, t:80, the average confidence value is 

(80+70+90+80)/4 = 80, this value compare the user-defined confidence value 100 as the 

picture 

 Minimum Check: It will let the user-defined confidence level value compare with the truly 

tesseract confidence level every character choosing value. E.g. Test, T:80, e:60, s:70, t:80, every 

value compare the user-defined confidence value 100 as the picture 

Confidence Level: This is user-defined confidence level value, if the value is higher than truly 

tesseract confidence level value, the returned string is shown on “Not Recognition” and record the 

every character confidence level value (possibility value) in the log, truly recognition value and save 

the error ROI image on .tiff format. The more detail for the log description and image information is 

in the next section. 

 

Pre-Process setting: 

There will include some image processing options for user, this is considering to increase the 

accuracy of the tesseract OCR recognition result: 

Choose existed 

configuration  

Load the configuration 

Load the 

default 

configuration 
Search tesseract 

Parameter 



Pre-processing: You can select the preprocessing using on the ROI image. There are three options: 

Gaussian Blur, Scale up and Binarization. The Scale up and Binarization are enforced to use for more 

accurate OCR result. For the Binarization, setting -1 is auto-calculate the best value. Otherwise, the 

value interval is between 0~255 by manually setting. The preview image is saved on the C:\_. 

Resize Image Algorithm: This is the resizing image algorithm for user setting. It will operate when 

the image height is lower than 33 pixels. It will increase the OCR accuracy. Besides, it will help user 

get the error ROI on the twice image. If you select the Interpolation, you can set the ratio of width 

and height. Super resolution does not provide the size settings cause the designed algorithm. 

 

White List: 

It provides whitelist to let you set the specific characters to recognize. E.g. If you check the 

enable radio button and input the 0123456789,:/, the OCR result characters will only restricted in 

the characters set. The image character “O” will force to change to “0” character because of the 

configuration set [0123456789,:/] is only included the “0” and excluded the “O” 

Black List: 

It provides black list to let you set the specific characters to exclude on the recognition. E.g. If 

you check the enable radio button and input the 0123456789,:/, the OCR result characters will be 

recognized and excluded in the characters set. The image character “0” will force to change to other 

character like “O” or “o” but it never to recognize to “0” character because of the configuration set 

[0123456789,:/] is only excluded the “0”. 

 

Log Format & Path: 

 ROI Image 

 ROI saving picture path:  C:\TESS_ROI_IMG\ 

e.g: C:_\TESS_ROI_IMG\ 

 ROI image file name: ImageLayer + ROIImage + ROIID + ‘_’ + year +’ –‘ + month + ‘- ‘ + day 

+ ‘ _’  + hour + ‘. ‘ + min + ‘.’ + sec + .bmp 

(ImageLayer-ROIImageID_yyyy-MM-dd_HH.mm.ss.bmp) (To avoid the different image 

layer has the same ROI ID) 

e.g: getimg_001-ROIImage6_2018-08-30_12.00.00.bmp  

 Log 

 Tesseract log path: C:\Program Files\ADLINK\DEX-100\main\Dex-100\log\ 

 Tesseract log file name: logfile.txt 

 Tesseract log format:  

Result: [OCR Result], confidence level : [truly tesseract confidence level value] lower than 

user input value: [user-defined confidence level value] 

Confidence Level Info: symbol:[chosed character], conf:[chosed character confidence level 

value]  [possible character 1], conf: [possible character 1]  [possible character 2], conf: 



[possible character 2] and etc. /// (end of the 1st character) 

 

e.g: Result:Itudio Code,confidence level:85 lower than user input value:100  

2018-09-18 10:51:17.9493 | INFO | Script | Confidence Level Info: 

symbol:I,conf:91.562378 [I],conf: 91.562378  [l],conf: 91.389709  ['],conf: 90.687805  

[|],conf: 90.467407/// symbol:t,conf:72.610962 [t],conf: 72.610962  [fi],conf: 

58.036041/// symbol:u,conf:94.302422 [u],conf: 94.302422  [U],conf: 87.742798/// 

symbol:d,conf:82.956841 [d],conf: 82.956841/// symbol:i,conf:88.855942 [i],conf: 

88.855942/// symbol:o,conf:86.132683 [o],conf: 86.132683  [0],conf: 83.588768  

[O],conf: 81.331100  [c],conf: 75.669678  [Q],conf: 74.847641  [G],conf: 74.397995  

[U],conf: 73.761749  [a],conf: 73.737335  [e],conf: 73.519440/// 

symbol:C,conf:85.817001 [C],conf: 85.817001  [€],conf: 71.201958  [c],conf: 

70.844307/// symbol:o,conf:83.627655 [o],conf: 83.627655  [0],conf: 81.249893  

[O],conf: 79.682175  [D],conf: 76.442062  [Q],conf: 76.253937  [c],conf: 72.360229  

[U],conf: 72.203735  [G],conf: 72.166687  [e],conf: 72.152779  [a],conf: 70.793457/// 

symbol:d,conf:82.522148 [d],conf: 82.522148/// symbol:e,conf:86.857246 [e],conf: 

86.857246  [a],conf: 76.896622  [&],conf: 75.992401  [E],conf: 73.676300/// 

 

Press OK if all the settings are ready, the new setting will default selected in Existing ROI 

Settings of ROI Setting form. Also you can preview it and finish this ROI setting by the “OK” button. 

 

 Tesseract OCR management: 

This function provides the setting the tesseract configuration for ROI items, and we show how 

to use it as follow. 

1. Click FileLoad 

 

2. Choose the .blf file 

1
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 3 



 

3. Click the image layer 

 

4. Click the ToolsConfigTesseract OCR SettingOCR Management 

2
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 3 

3

 

 7

 3 



 
5. Choose the left ROI data (Support multiple choices)  

 
6. Edit Checked ROI 

1) Choose the other setting configuration 

2) Click the Replace  

Or 

1) Choose the other configuration data 

3) Click the New to create new setting configuration (Refer to previous section) 

 

 

5

 

 7

 3 

6

 

 7

 3 



 
 

7. Click “Apply and Save” or “Exit without Change” to complete 

 

6.10. OCR Enhancement for Special Case 
For some cases, the character O and 0 [S and 5], [I, l and 1] is not easily to recognize by the 

Tesseract OCR. We provide another method to solve it as follow. 

1) Open the Tesseract OCR training tool: ToolsConfigTesseract OCR SettingTraining 

Tool 

 

2) Choose your ROI 
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 3 
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3) Click “Make Box” 

4) Click the “O” or “0” on the word 

 



5) Input the right character on the Label 

 
6) Click “Save O 0 group” 



 
7) If more than one “O” or “0” in your word, you can go to step 4) and repeat 4)~6) 

8) If you train these characters in other PC, remember to copy your training images to the 

DEX100 C:\_ 



 

9) After training these images, click the ToosOCR Mode Setting 

 
10) Check “with O/0, S/5, I/l/1 post-processing” 



 

11) Click “Yes” to restart the DEXPro and the function is enable 

 

 

  



7. DEX-PRO function reference examples  

7.1. Create a simple OCR script (Asi-OCR) 
1) Setup Path.  

Before you use script editor, you must set Path first. It will restore script info(*.spt), image layer(*.bmp) 

and BMP List file (*.blf) at the folder, see 7.10 for more details for common files and directory. 

Select Config Script panel and click Select button  

 

 

2) Connect to and operate with remote host  

Click Connect button and you will see host’s desktop in real-time on the right part. Click Control button 

then you can control host machine with mouse in left panel as remote desktop. Operate the host to the 

scene that you want to extract data with. 

 



 
 

3) Take screen-shot for host screen. 

When the desired scene of host is ready, click Snapshot button. A screen-shot image will be add as new 

image layer, getimg_001.bmp, into imgae list.  

 

  

4) Click button Disconnect if all desired images are collected, otherwise repeat step 2 and 

3 to captured images. In this case, we capture 2 images for each tab respectively.  

 

5) Select ROIs for OCR.  

Click item in layer list, eg., getimg_001.bmp to show the screenshot image. Choose a 

ROI with left drag and add Send OCR button. Now two instructions, “Get bmp rect” and 

“Send OCR” will be added to script. If you are using Tesseract OCR mode, follow the relative 

Click Connect 

Remote desktop 

Click 

Snapshot 

Image 

layer list 



steps described in section 6.10 after pressing the Send OCR button. 

If you want to modify the ROI’s position and size, simply press down the right mouse 

inside the target ROI. The Edit Frame form will pop up for you to modify its position (X, Y) 

and size (Width, Height).  

 

6) Repeat Step 5 if more ROIs for OCR are needed. In this case we select 1 ROIs for layer 

image1 and 3 ROIs for layer image2. Notice that after editing each layer, press Save 

Scripts or File->Save File to save the temp.blf in related folder you provide. 

 

 

7) Right click on layer list and select Combine Script->General. The instructions in each 

layer will be integrated to single script file. 

Choose OCR ROI with left drag 

Add OCR button and add 

scripts 



 
 

8) Save script with saving dialog. After step 1-7, the folder will contains 2 spt files for 2 

layers respectively. Input a different name for the script file., eg run.spt 

 

9)  Load previous save script.  

The generated script contains default instructions: mainly twice OCR instructions, “Get bmp 

rect array” for two layer 1 and 2. An instruction “img refresh” is suggested to refresh host 

screen to capture stable image before OCR.  



 

10) Editing script. 

In the last step, we need to modify the default script to fulfill data extraction for tab page 1, 

and page 2. The script supposes to connect host in the beginning, and click on tab1 then 

perform OCR, following another click on tab2 and OCR analysis. See Chapter 5 for detailed 

instruction description and examples. 

 

11) Run Script 

Click button Run Scripts then you can see DEX-100 operates as script instruction. When the 

script is finished, click Tools->OCR Table Management to see the OCR result. The accuracy of 

OCR result is not good, we need to train OCR engine to improve the accuracy. Note. If the 

OCR engine cannot detect text in ROI image, OCR result will be “Asi-OCR” and screen shot 

image will be saved in “C:\OCR_Failed”. 



 

7.2. OCR Training example 
 Tesseract OCR Training 

When the OCR Mode used in Tesseract, you can find a training tool in Manu bar here:  

Tools->Config->Tesseract OCR Setting->Training Tool 

After press the “Training Tool”, the training Form will pop up like below,  

 

There are three parts in this training tool: (1) TrainedData; (2) Fonts; (3) Sample Images. 

Each of the three conponent will included in the example below: 

Step 1: Create a TrainedData 

Double Click the TrainedData label at the left list view, then the funtions will apear in the right panel. 

There are two label for you to add or delete the created trainedData. Now, press “Add New TrainedData”.  



 

 After pressing the “Add New TrainedData”, the required information are shown below. Here, input your 

trainedData name in the text input area. For this example, we named the trainedData “myTrainedData”. 

Simply press “Add” button to add this trainedData to the record file.  

 

Simply press “Add” button to add this trainedData to the record file. The created trainedData will 

shown below this panel. 

 

 

Step 2: Create a Font 

After you created the trainedData, we continuesly create the “Font”. This “Font” means where the 

training images(Training images now are not added yet and will describe in the Step 3.) belongs to. Double 

click on the “Fonts” in the left panel and there will show a new tab item called “Fonts” in the right panel. Also, 

there will have two function labels for you to add and remove the Fonts. 

 

 

Now, press “Add New Font”, another tab item shown jist next to the Fonts tab. You need to input the 

requied information for this Font you created: 



(a) Font Name: Denotes the Font you created. In this example, we name it “myFont”.  

(b) Description: Type some descriptions for this Font you created.  

(c) Properties: This properties should set based on the image. If your images is bold, select the 

Bold button. In this example, we assume that in our images include Bold and Fixed Width.  

After all the properties are provided, simply press the “Add” button. 

 

After you add the font, the information will shown below just like TrainedData did.  

 

Step 3: Import images into this Training Tool 

In this step, we are going to adding the images which are used for t raining. Double click on the function 

label “Sample Images” in the left panel and there will apear the “Sample Images” tab. Of course there have 

add and remove function label for you to add and remove the images. Also, there have simple viewer 

function for you the see the images we had added. 

 

Just like trainedData and Fonts did, press “Add New SampleImage” function lebel. The “Add Sample Image” 

tab occurred. 

 

Here you can use Browse Files or Folders to import the images you want to use for training.  In this eample, 

we use “Browse Files” to import the images we are going to use. 



  

Multi-Select the images and open them. The imported images will listed in the panel. Here now you 

need to indicate each images belongs to which Font. In this example, we indicate each image to the font, 

myFont, we created just now. After you incated, it looks like below:  

 

Then Press “Add” button below this panel to finish the import. And you will see the imported image in 

the “Sample Images” tab. 

 

Step 4: Boxing and each imported images and indicate to Font 

In “Sample Images” tab, double click each sample image to do this step.  

 

Here, we use Sample Id 1 for example. After you double click on the row, the “Edit SampleImage 1” tab 

occurred. Press “Make Box”(orange region) button to create the boxes of each character. The box result will 

Double click 
each row to 
do this step. 



show(red region). You could edit the boxes position and size by clicking one of them, and manipulate the  

sizing pins or by using the textboxes to manually change the x, y, width and height values. The box label can 

be changed by pressing a keyboard key while the box is selected, or by changing the value in Label text box. 

More boxes can be added by using the "Insert ROI" button where it will add the new box on the right side of  

currently selected one. Boxes can be deleted as well by using the "Delete ROI" button.  

 

 

After Boxes are proper modified, “Apply” button should be then pressed(sky blue rectangles). 

Otherwise there will not be stored. 

Continuesly press “Train Box” button(green rectangle) for generating the required features for further 

training. Also check the Font is belongs to which one you want to assign. Notice that you should also press 

"OK" or "Apply", otherwise changes will not be committed until "OK" or "Apply" button(blue rectangles) at 

the end of the page is clicked. 

 Do this for each image you imported. This is the pre-procedure that you are getting start the training. 

(As shown below) 

 

Step 5: Assign the Font to TrainedData 

After you created the font, assign it to the TrainedData. In this example, we assign “myFont” to 



“myTrainedData”. Double click the label TrainedData in the left panel(blue rectange), then double click on the 

row in the right panel. The information of the “Edit TrainedData myTrainedData” shows. Select the font we 

created(myFont), then press “Add Font” to add it into this trainedData(myTrainedDAta).  

 

 

Step 6: Train the TrainedData we created 

Go back to the TrainedData, there the TrainedData can be press the “Train” button. After you press the 

“Train”, page will redirect to the new tab “Train TrainedData myTrainedData”. Still simply press the “Train”.  

 

 

When training process finished, a message box will show to let you confirm to store the traineddata to the 

Dex-Pro for using. Just press Yes and complete message shown. Here, we can go back to use the traineddata 

we trained(see the orange rectangle, it will apear in the settings and you can use the trained result.) . 



 

 

 

 



 Asi OCR Training 
In this example, we train OCR with OCR_Tool (“C:\Program Files\ADLINK\DEX-100\main\OCR_Tool.exe”) to 

improve OCR accuracy in example 7.1.  

1) Run OCR_Tool.exe and open the Correction dialog by click menu item Tools->Correction.  

DEX-Pro added all letters in to OCR DB aftering execution script in example 7.1. 

 

 

2) Correct OCR DB 

The first letter is 2, but recognizied as S. We need to correct it. Type correct text in the TextBox and 

pressed the button change. 

 

Type correct text and press change 



 

3) The correction is not limit to single character. If the letter contains more than one character, it is able to 

input mulitple characters. 

 

4) Make correction for all the letters in DB. Then run the script in example 7.1 again.  

The reuslt was imporeved significantly. We can correctly recognize alphat and digital numbers. With closer look, 

the digit ‘8’ still incorrect. It should be 2047480 in stead of 2047400 for the fisrt ROI. Similar, it should be 1819, 849 

for seccond and third ROI respectively.  

 

5) Adjust similairty.  

In this case, the similarity threshold is too low to tell digit 0 and 8. We find no letter 8 in OCR DB with Correction 

dialog. We can use “Adjust Color Variation” in OCR_Tools to find proper similarity. We can find and load ROI image 

in C:\OCR_IMG and adjust similiary to 0.85. The first recognition reslut is 2 0 4 7 4 0 0. We modify it to 2 0 4 7 4 8 0 



and press the button Change DB save the result. See section 4.1.2 for more details of “Adjust Color Variation”. 

 

 

 

6) Check DB, the letter 8 is now added to DB. 

 

 

1. Load ROI 

image 

2. Set chksame to 0.85 

3. Press Format OCR and input correct text 4. Press Change DB 



7) Apply the similairty in DEX-Pro to 0.85, and run the scirpt again. 

 

8) Check the results again, now we can recongize all digials correctly. 

 

7.3. Page identify example 
In previous example, we assume the page is stable and page changes only when mouse clicks on the 

tab control. For more complex environment, for example the page tab will randomly change itself 

without any click. In this case, we need to identify what the current page is before OCR to extract 

correct data.  



 

1) Set the same path as sample 7.1 and load tmp.blf file which contains layer information.  

2) Select unique pattern to identify the page.  

In page identify editor, select first layer by clicking “getimg_001.bmp”. Drag mouse to select the 

pattern. In this case, we select the tab label as the pattern. 

 
 

3) Repeat step2 for all pages.   

 

 

4) Save page identify config by clicking “Save Config”. The config can be load by manually 

Drag ROI for page identify 



click “Load Config” or automatically when Dex-Pro is started if the option “Auto Load 

Config File” is checked. Note, the config file is saved and loaded with the PATH directory, 

therefore set PATH directory first with correctly access the config file. 

 

 

5) Check page identify result. 

Connect remote host and check the result with online screen. The identify result is show 

on the status bar. For example, the status is “Normal(1) 0” which means Page 1 is 

identified with the recognition of Pattern 0. A page can has multiple patterns and all 

patterns have to be recognized to identify the page. If the page is not recognized correctly 

adjust the threshold for pattern. 

Note 

The default type of page status is “Normal”. If you want to set another type of page. Please see 

the detail in section 7.5 Warning /Alarm setting flow. We provide some parameters for page 

definition are described as following figure. 

Figure (The page type parameter) 

Page Type Page Configurations 

(Parameter)  

Description/Remark 

Normal (default)  Description Normal page only using the 

description of page. 

Warning  Message Number 

 Description 

User can define the warning 

number/code of their warning 

page. 

Alarm  Major Code 

 Minor Code 

 Description 

User can define the alarm 

Major/Minor code of their 

alarm page. 

 

Page Type: define which type the page is 

 Normal: normal page (The page number will display in navy blue in status bar) 



 Warning: warning page  (The page number will display in orange in status bar) 

 

 Alarm: alarm page (The page number will display in red in status bar) 

 Other: reserved, no use 

Major Code: The major code number for an alarm page. (Not mandatory) 

Minor Code: The minor code number for an alarm page. (Not mandatory) 

Message Number: The warning message number for warning page. (Not mandatory) 

Description: Message for page. (The description will show in op screen and communication module message 

(DDS/RESTFUL)) 

Rectangle: load location information of warning image from configuration (*Note1). (Not mandatory. If you want to set 

Warning/Alarm Pop Out Window. Please see the step of setting in Section 7.5. 

Save Page Identification Configuration: save configuration to file. 

Note1 

The rectangle parameter only using for Warning/Alarm Pop Out Window. 

 

 

 

 

6) Use page information in script.  

We modify the script in example 7.1. The script will check the page id first; if it is page 1 then 

go to label P1 to extract three ROIs data with OCR. If page id is 2, go to label P2 to apply OCR 

for another two ROIs, otherwise, for page id is 3, 4 or else, go to end.  

 



 

 

The Threshold of PI pattern 

1. The Threshold of PI pattern is a baseline of the difference in PI pattern and current image. 

If the difference is less than the threshold, DEX100 recognize this PI pattern, please see the 

following table. 

Compare between the threshold (A) and the difference in PI pattern and current image (B) 

A > B DEX100 recognize PI pattern success 

A < B DEX100 recognize PI pattern fail 

That means that the larger threshold is easier to recognize the PI pattern, but it also 

increases the chance of recognizing the PI pattern but the image is not in actual. 

2. Added an API, Dex100_GetROIThreshold(UINT Number, UINT ROIIndex, UINT Width, UINT 

Height, UINT &RealThreshold, UINT &AdvisedThreshold, UINT &AdvisedThreshold_Min, 

UINT &AdvisedThreshold_Max) which returns the real difference, advised threshold, min 

of advised threshold and max of advised threshold in this PI pattern. 

3. When user creates a new PI pattern, DEX-Pro gets the current different and advised threshold value 

by this API. 

4. Add a button “Update Page Image & Threshold” to reset all ROIs in the current page to the advised 

value. And DEX-pro will capture an image to replace the image layer of this page and calculate all 

thresholds in the page. 

Note. 

1. There are two key values in the advised threshold, Current difference and Dynamic Noise. 

The Current difference  =  RealThreshold 

Dynamic Noise    =  The result of Video Quality Analysis testing which is in  

C:\ProgramData\ADLINK\DEX100\VideoQuality\VideoQualityStatistics.xml or 35 as default. 

The minimal of advised threshold  = Current difference * (1 – (Dynamic Noise/100)) 

The advised threshold    = Current difference * (1 + ((Dynamic Noise/2)/100)) 

The maximal of advised threshold  = Current difference * (1 + (Dynamic Noise/100)) 

2. The following is an example situation of fine-tune the PI pattern threshold :  



Assume we have a page (ID = 4) with PI pattern 16 – 29, 

That means the DEX-100 can identify the page 4 if all PI 

patterns 16 – 29 are recognized. 

 

 

 

 

 

 

 

 

 

 

 

If the page identify failed somehow, please check the page status of DEX-pro after connecting, it 

shows what are patterns recognized. 

 

There is no 25 in the Page Status, it means the DEX-100 fail to recognize PI pattern 25. 

Please adjust the threshold of PI Pattern 25 to larger one Or click the button “Update  

Page Image & Threshold”  to reset all ROIs in the page to the advised value and try again. 

       

 

DEX100 identify page 4 successfully. 



 

Setup steps 
1. Sets the output image of target machine to the page which is been identified. 

2. Create a new PI pattern, DEX-Pro will show the advised threshold and update the threshold 

automatically. 

 
When there is no signal input, DEX-pro shows “Please check signal” on UI and stop advising 

threshold value. 

3. After creates all RIOs in this page, press “Save Config ” to save data. 

4. When the source image changed (ex. change target) or the DEX-100 identifies wrong Page, press 

“Reset all ROIs in this page” to set all thresholds of ROIs in this page to the advised value.  

 

DEX-pro pups up a message to remind user that makes sure the target machine’s image is the same 

page as setting or the advised threshold value will be wrong. 

 

7.4. MSMQ Example for switching different 

script 
In this example, we have a general script to extract data from host machine. When receiving a 

specific MSMQ event, we reset host machine. Restart to extract data after resetting. 

 

1) Prepare one script, OCR.spt for data extraction and one script, reset.spt for reset host machine. 

2) Set OCR.spt as the main script and enable run script when HID timeout. See section 3.12 for 

more description of Background Schedule Setting.  



 

3) Set MSMQ Execute Scripts Management 

Select reset.spt for the first command, EAPCommand1. 

 
4) Click Start(Auto) to run OCR.spt 

5) Send MSMQ to OLP.EQP001.To.EAP with message “EAPCommand1” with external utility. In this 

case we use msmqmngr (http://msmqmngr.codeplex.com/). 

 

The message in Windows’ Computer Management showed below. 

http://msmqmngr.codeplex.com/


 

6) When Dex-Pro receives the message, it will stop OCR.spt and execute reset.spt for reset 

procedure. The left-bottom panel in Autorun Script will show the received message and 

corresponded script. 

 

7) 30 Sec after finish reset.spt, Dex-100 will restart data extraction. 

7.5. MSMQ Example for getting/setting OCR 



table value 
In this example, we show how to access the OCR table value by MSMQ command. There are two 

MSMQ command “EAPSetEC” and “EAPQueryEC”. If you want to use these two MSMQ 

commands to access the DEXPro OCR table value. You need to write a MSMQ program to 

communicate with DEXPro. Remember if you want to send the message in your program, it will 

need to modify character for some reserved word on XML. E.g. &lt to replace <. These two 

commands format are as follow, 

 

EAPSetEC: 

<Transaction Name="EAPSetEC" TID="2177" Type="Request" DateTimeSent="2019/12/09 

01:11:27" DateTimeReceived="0001/01/01 00:00:00.0000000"> 

<ECItem> 

<ECID>10</ECID><ECValue>aaa</ECValue> 

</ECItem> 

<ECItem> 

<ECID>20</ECID><ECValue>bbbb</ECValue> 

</ECItem> 

</Transaction> 

 

ECID is the OCR table index and ECValue is that you want to set or modify. Moreover, reply 

message is  

 

<Transaction Name="EAPSetEC" TID="2177" Type="Reply" DateTimeSent="2019/12/09 

01:11:59" DateTimeReceived=\"0001/01/01 00:00:00.0000000"> 

<ErrorCode>0</ErrorCode><ErrorText></ErrorText> 

</Transaction> 

 

You can check ok if the error code is successful. 

 

EAPQueryEC: 

<Transaction Name="EAPQueryEC" TID="2178" Type="Request" DateTimeSent="2019/12/09 

01:11:27" DateTimeReceived="0001/01/01 00:00:00.0000000"> 

<ECItem> 

<ECID>10</ECID> 

<ECID>20</ECID> 

</ECItem> 

</Transaction> 



 

ECID is the OCR table index that you want to query. Moreover, reply message is  

<Transaction Name="EAPQueryEC" TID="2178" Type="Reply" DateTimeSent="2019/12/09 

01:11:59" DateTimeReceived=\"0001/01/01 00:00:00.0000000"> 

<ECItem> 

<ECID>10</ECID><ECValue>aaa</ECValue> 

</ECItem> 

<ECItem> 

<ECID>20</ECID><ECValue>bbbb</ECValue> 

</ECItem> 

<ErrorCode>0</ErrorCode><ErrorText></ErrorText> 

</Transaction>" 

 

You can get the value between the ECValue tag and check ok if the error code is successful.  

 

 

7.6. Warning/Alarm (Pop Out Window) setting 

flow 
This example will demonstrate the identification of warning page and displayed warning page on OP 

Screen when it is detected. In example 7.3, there are 4 normal pages, one for each tab. In this 

example, in additional with the original normal pages, one message box as a warning page will be 

included. 

  

 Open page identification editor select pattern of the 5th page. Page 1-4 are the same as example 

7.3. 



 

 Switch right panel to Warning/Alarm Image Clip. Drag mouse on screen shot image to select 

warning/alarm clip which will be display on the OP Screen when warning page is identified. The 

selection area will be marked with orange rectangle. You can see the relevant parameters 

displayed in the table in the upper right corner. Then, the orange rectangle parameter save 

(X/Y/WIDTH/HEIGHT). Click “Save Config” button. The “orange rectangle parameter” will map to 

page configuration “rectangle” parameter (CropX/CropX/width/height) *Note1.  

 

Note1 

 The rectangle parameters are saving in warning-config XML format. 

 Only the warning and alarm pages can set the pop out window. This function is not mandatory and the 

user can not set it.  

 



 

 Set page type for page 5.  

Open page identification setting (Tools -> Configuration Management -> Page Identification page 

configuration). Set page type, major code and minor code to Alarm, 2, and 1 respectively for 

page 5.  

Note if it is an alarm page, you need to assign code and minor code, and for warning page you 

need to assign message number and the description, see Section 3.1.2 for more details. And 

remember to sync the warning-config.xml, you need to load by clicking the “…” on the Rectangle 

label right side. After loading the warning-config.xml, click “Save configuration” again. 

 

 Load and run script in example 7.3  

2. Drag to select image clip. 1. Switch to Warning/Alarm 

Image Clip Tab  

3. Save Config 

1. Set page type, major code 

and minor code 

3. Save configuration 

2. Sync the warning information  



When main program identifies the alarm page, the main program status bar shows “Alarm” with 

page id in red background color (orange background color for warning page). 

 

 Alarm images on OP Screen. 

The alarm image will be displayed on OP Screen. Each time the alarm page is detected, the 

alarm images will be showed. For example, the figure below showed OP Screen with two alarm 

images. User needs to remove the image by click on it otherwise OP panel will be disabled. 

The “detection rate (*Note1)” and “maximum images” can be showed on OP Screen are 

configurable. They can be set on “Tools -> Configuration Management -> Page Identification 

page configuration -> Warning/Alarm -> Update Rate” and “Tools->Config->OP Screen Setting -> 

Max warning images displayed”, respectively. See Section 3.1.2 for more details. 

 



Note1 

Because the window of the warning page may stay for many seconds, in order to avoid the pop out 

windows of warning /alarm being quickly generated, the window of the same page will be updated 

according to the detection rate. (default is 5 seconnd) 

 

 If DDS or Restful module is activated the alarm code will be sent to remote server and logged on 

the console. The configuration of DDS/Restful server is under Tools->Config -> Configuration 

Management -> DDS & REST OCR Configuration. See more details for setting communication 

module in section 3.1.2. 

 

7.7. Script Examples  
 

Example 1: PI.spt 

This script repeatedly clicks 4 tab pages in sequence. If warning message is displayed, the script wait until warning 

message is closed. After warning message is closed, script goes back to clicking task. 

 

Script Instructions:  



 
 

Instruction Description 

#1 Connect  

Connect to host machine. 

 

#3 Set Label 

Set a label named “Loop”, for repeat clicking  

  

#4-#13 

Click each tab in sequence and if a warning page is identified then jump to warning label (#15) to sleep. 

 

Tab-Clicking Section 

Warning Handling Section 

Connection to Host 

Disconnection from Host 



 

Detail settings of instruction #4 for page identification: The warning page is set with id = 4. Thus the setting, Y = 1, W = 4, 

Text = “warn”, means if current page id = 4 (it is warning page), then jump to the instruction labeled with “warn”. 

 

 

Detail setting of instruction #5: Send a left click event to host at X=254, Y=631 to click 1st tab page. 

 



 

Detail setting of instruction #14: Go to the instruction with label loop. 

 

 

Example 2: OCR.spt 

Repeatedly extract value from screen by OCR function and save and upload selected OCR results to server. 

 
 

Instruction Description 

#4 Get bmp rect array: Applied OCR function to ROIs of current image, then save the result to data tables. See OCR 

section for more details.  

 

OCR Section 



 

 

#5 MSG_SAVE_TABLE_TO_LOG 

Save data table to log file. 

 

 

Detail settings of instruction #5 for saving data to log file: The setting Text = 1~10 selects Item 1 -10 to be saved, the rest 

of items will be ignored. The setting H = 1 upload data value of selected items in string format to server using DDS 



module. 

 

 

Example 3-1: TableCompare1.spt 

Just like the Mode “Check Text” described above, there are two compare mode called “Check Text from Table” 

and “Check Text from File”. In this example, we describe about the “Check Text from Table” and you can figure out the 

“Check Text from File” in the next example. Select the OCR ROI first: 

 

 

All the steps are the same with Example 3-1 and the only difference is the Mode you need to change to “Check 

Text from Table” just like: 

 

After change Mode to “Check Text from Table”, you do not need to input the Text for matching before press the 

Add OCR button. The compare mechanism is based on the settings about the table. Here you can see the instruction 

called “Table Compare” comes after the instruction “Send OCR”, like below: 

Index of the Table item 



 

Then focusing on “Table Compare” and right click for the pop up menu to modify the script, like below: 

 

The detail settings of the instruction #4 “Table Compare” form showed up. Type the compare result into the quotation 

mark, in this Example we type “Compass” (blue arrow). Choose the Table index which you want to compare from the 

table, in this example our index is 0 (red arrow). More detail settings you can reference to 5.2 Script Instruction 

Description. 

 

 

Example 3-2: TableCompare2.spt 



In this Example, the difference between “Check Text from Table” is changing the Mode to “Check Text from File” before 

pressing the “Add OCR” button. 

 

The added instruction is also called “Table Compare” comes after the instruction “Send OCR”, like below: 

 

 

Prepare the result file from the disk and the content which looks like:  

 

In this example, we same in drive C: and named it “input.txt”. Notice that the file cannot exist any carriage return and 

line feed which means there only exist single row in the txt file. 

 

The detail settings of the instruction #4 “Table Compare” form showed up. Type the compare file path into the 

quotation mark, in this Example we provide the file path: “C:\\input.txt” (blue arrow). Choose the Table index which you 

want to compare from the table, in this example our index is 0 (red arrow). More detail settings you can reference to 5.2 

Script Instruction 



 

 

Example 4 ScreenCalibration.spt 

Screen calibration instruction is used to calibrate horizontal shift within ± 3 pixels. This example set a label named 

“DoCab” (instruction #4) for the following screen shift calibration (instruction #7). If calibration failed, it will jump back 

to “DoCab”. The script will count trial number using “set Table Value” (instruction # 5) and continuous try calibration if it 

is less than maximum trial number (instruction #6). 

Note the calibration is done with page identification patterns, in others words, if there is no page identification pattern, 

this instruction will result in fail.  

 

 

Instruction Description 

#3 set Table Value 



 

Detail settings of instruction #3 set Table Value: reset counter by set item0 to 0. 

 

 

Detail settings of instruction #4 Set Label: set a label named “DoCab” as the section of screen shift cablication. 

 



 

Detail settings of instruction #5 set Table Value: item0 will plus 1 by with setting Q=4 and Text = 0. 

 

 

Detail settings of instruction #6 Table Compare: If Item0 < 3, script will go to instruction #7 to do calibration, otherwise 

it goes to instruction #8.  

 



 

Detail settings of instruction #7 Screen Shift Cab: perform screen calibration. If calibration failed it goes to label 

“DoCab”. 

 

OCR alphabet and number identification 

 

This function allows users to set the OCR format on 5 types in the edit phase and in the extraction phase, the OCR 

will follow this setting character format type to interpret the corresponded alphabet or number. 

 

Dex-Pro (Asi-OCR) 

 Edit Mode – Add a new ROI item  

2) Choose the Mode to “Multi-Character Format” in the “Send OCR” block.  

3) Key in the character type for every character one by one, and the character format type is as follow: 

1) A: all 

2) N: Number 

3) L: Uppercase letter 

4) l: Lowercase letter 

5) W: Uppercase and Lowercase letter 

For example, if the ROI have 5 characters, we can set NAlll in the Format Text Box 

4) Click the “Send OCR” to get testing result in “OCR test” block 

5) Click “Add OCR” to add script in the instruction 



 

 Edit Mode – Modify a exist ROI item 

1) Click mouse right button on the “Send OCR” in the “Instruction” block and choose the “Modify Script” 

2) Modify the “Multi-Character Format” in the “Scheduling instruction set” dialog 

3) Click “OK” 

 

 

 



 
OCR Tool 

Test the OCR –  

1) Open the “OCR_Tools.exe” on “C:\Program Files\ADLINK\DEX-100\main” 

 

2) Click “Adjust Color Variation” on the “Tools” submenu 



 

3) Open your ROI picture 

4) Input the OCR format, for example, NAlll 

5) Click the “Split Picture”(“Format OCR” is the same) and the result will show on text field 

 

Train the OCR database with character format type –  

1) Click “Correction” on the “Tools” submenu  



 

 

2) Find the character you want to adjust, for example, “1”  

3) Check the “Need to Change” to let this character editable 

4) Input correct value  

5) Check the “Is Letter”, suggest check it because it will match to single character in the ligature 

6) Choose OCR format type 

a) 0: None (ALL) 

b) 1: Number 

c) 2: Uppercase Letter 

d) 4: Lowercase Letter 

7) Click the “change” button to save this correct from (4) and OCR type format from (6) 

 

  



7.8. Full Control mode and Data Extraction 

mode switch 

7.8.1. Mode Switch by DI 

Data-Extraction Mode with running script can be interrupted by digital input (DIN2) signal. There are two modes for the 

current DEXPro running script status; they are “Start Auto Run Script Mode” and “Stop Auto Run Script Mode”. The first 

one is the script already auto running and the “Start(Auto)” button is pressed, and the other one is the script not 

running and the “Stop(Auto)” button is pressed. 

Start Auto Run Script Mode: When digital input (DIN2) is triggered and connected, Dex-100 will immediately stop 

running script and start running the background schedule script. And if the DIN2 is disconnected, it will stop running 

script. After operation of target machine, Dex-100 will automatically switch to Data-Extraction Mode again; restarting 

script if keyboard and mouse (HID) keeps idling over timeout. 

Stop Auto Run Script Mode: When digital input (DIN2) is triggered and connected, Dex-100 will immediately start 

running the background schedule script. And if the DIN2 is disconnected, it will stop running script. 

For the DIN1, it doesn’t impact any behavior on the Start Auto Run Script Mode and Stop Auto Run Script Mode. 

There are two DI labels to show the DI1 and DI2 status. When the DI1 detects the signal on 24v, it will turn on and the 

label will be changed from DI1_OFF(gray) to DI1_ON(green). However, the DI1 detects the signal on 0v, it will turn off 

and the label will be changed from DI1_ON(green) to DI1_OFF(gray). It is also the same as DI2 status. 

P.S. Remember if the DIN2 is connected/disconnect quickly, it may be abnormal. Suggest the trigger is bigger than 1 sec. 

If your DIN1,2 Label status is abnormal, please re-trigger bigger than 1 sec again and it will recover original state. 

 

 

7.8.2. Mode Switch by OP Screen Button 

Without digital input (DIN2) button, there is another way to switch to Full-Control Mode during Data-Extraction. Click 

the button Full Operation in OP Screen, Dex-100 will stop running script and switch to Full-Control Mode. 



 

7.9. OP Screen Mode 
Section 7.3 demonstrated the use of page identify function. Continuous with example 7.3, this 

example will show the steps to display host pages on OP-Screen.  

 

1) Set the path and load page identify configuration as 7.3. 

 
 

2) Open OP Screen Setting (Tools->Config->OP Screen Setting) and set Host view 1 to id 1. The 

panel on the right hand side will show the corresponding image layer 1. 



 

3) Repeat step 2, setting Host View 2 to page id 2, Host View 3 to page id 3 and Host View 4 to 

page id 4. Press button Done after setting. 

 

4) Load script file for example 7.3 and set Q to 1 in connect instruction to enable OP-Screen. 



 

5) Run script and remote host screen will be displayed on OP Screen. 

 

7.10. UWF 
Unified Write Filter (UWF) is an optional Windows 10 feature that helps to protect your drives 

by intercepting and redirecting any writes to the drive (app installations, settings changes, saved 

data) to a virtual overlay. The virtual overlay is a temporary location that is usually cleared 

during a reboot or when a guest user logs off. 

 

Dex-100 provides the UI to set the UWF, the entry point is on the main menu, 

[ToolsConfigUWF Setting] as follow picture. 



 

The UWF setting dialog will show.  

i. The left side data grid shows the current session setting folders or files  

ii. The right side data grid shows the next session setting folders or files 

iii. Add Folder: Add a folder to next session 

Add Files: Add a file to next session 

Remove: Remove the folder or file on the next session (right side data grid) 

iv. Enable UWF: Enable the UWF status “ON” (It will be open after restarting the 

Windows) 

v. Disable UWF: Enable the UWF status “OFF” (It will be open after restarting the 

Windows) 

vi. Commit File: It allows the file to add when the UWF status is “ON” 

vii. Commit Delete File: It allows the file to delete when the UWF status is “ON” 

viii. ON/OFF Status for current UWF session 

ix. ON/OFF Status for next UWF session 

  

 

The default protection folder can’t be removed, so if you want to remove, it will pop up the 
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alert. 

 

Remember when the UWF status turn on, the UWF window will become slowly to be opened 

because of it must read the current status by windows system response. Besides if re-install the 

SDK, remember to turn off the UWF first. 

 

7.11. Reload the backup 
To reload the backup files, click DEX-Pro Restore to ini files, OCR data and schedule files.  

 

 

To reload xml configurations and one machine initial file on your system, 



 

 

See backup section for more details. 

7.12. Common Directories and Files 
The following is the list of directories and files for Dex-Pro to save OCR images and scripts logs during data extraction: 

 BLF : BMP Layer File for editing script 

 SPT : Script File For Runtime 

 C:\_ : Contains OCR setting and OCRFile For OCR Training 

 C:\OCR_IMG : If a new word is found and added to OCR DB when perform OCR instruction, the ROI image 

containing new word will be saved in this folder.. (only OCRMode = 0 support) 

 C:\OCR_Later : Contains OCR letters as binary images. (only OCRMode = 0 support) 

 C:\OCR_NOT_RECOG: If OCR engine recognizes no word in a ROI image, the ROI image will be stored in this 

directory. (only OCRMode = 0 support) 

 C:\OCR_Failed: If OCR engine recognizes no word in a ROI image, the full screen-shot of host machine will 

be store in this directory. (only OCRMode = 0 support) 

 C:\Documents\RVM_OCR_IMG : 

If an OCR instruction’s Q equals 1, then a full screen-shot of host machine will be saved in this folder when 

the OCR instruction is performed. 

 C:\TESS_ROI_IMG : (only OCRMode = 1 support) 

If the OCR result confidence level is lower than user defined confidence level score, it will store the ROI 

images. 

 C:\Documents\RCM_TABLE_LOG :  

The path for instruction “MSG_SAVE_TABLE_TO_LOG” to save table items and OCR results in CSV file. 

 C:\Documents\RVM_OCR_CUR_ERR_IMG : Misjudgment pictures for cursor Detection 

If cursor detection failed, a full screen-shot of host machine will be saved in this folder. 

 C:\Documents\RVM_LOG :  



Log files for script instructions 

 C:\Program Files\ADLINK\Dex-100\main\Dex-100\logs:  

Detailed log files for Dex-100 status and script instructions. 

Note. The save image files will be deleted automatically when maximum number is reached or the file is expired.  

 


